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COMPUTER FUNDAMENTAL 

v What is Computer 

The term "computer" is derived from Latin word "computare" which means to calculate. 

Computer is a programmable electronic device that accepts raw data as input and processes it with set of 
instructions to produce result as output. It renders output just after performing mathematical and logical 
operations. The device also has memory that stores the data, programs and result of processing. 

It is believed that Analytical Engine was the first computer. It was invented by Charles Babbage in 1837. 
Charles Babbage is also considered as the father of computer. 

Ø Functionalities of a computer 

Any digital computer carries out five functions in gross terms: 
· Takes data as input. 
· Stores the data/instructions in its memory and use them when required. 
· Processes the data and converts it into useful information. 
· Generates the output 
· Controls all the above four steps. 

 

 

 

Ø Definition 
· Computer is an electronic data processing device which 
· accepts and stores data input 
· processes the data input, and 

                    generates the output in a required format. 

Ø Advantages 
Following list demonstrates the advantages of computers 

· High Speed 
· Computer is a very fast device. 
· It is capable of performing calculation of very large amount of data. 
· The computer has units of speed in microsecond, nanosecond, and even the picoseconds. 
· It can perform millions of calculations in a few seconds as compared to man who will spend many 

months for doing the same task. 

· Accuracy 
· In addition to being very fast, computers are very accurate. 
· The calculations are 100% error free. 
· Computers perform all jobs with 100% accuracy provided that correct input has been given. 

· Storage Capability 
· Memory is a very important characteristic of computers. 
· A computer has much more storage capacity than human beings. 
· It can store large amount of data. 
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· It can store any type of data such as images, videos, text, audio and many others. 

· Diligence 
· Unlike human beings, a computer is free from monotony, tiredness and lack of concentration. 
· It can work continuously without any error and boredom. 
· It can do repeated work with same speed and accuracy. 

· Versatility 
· A computer is a very versatile machine. 
· A computer is very flexible in performing the jobs to be done. 
· This machine can be used to solve the problems related to various fields. 
· At one instance, it may be solving a complex scientific problem and the very next moment it may 

be playing a card game. 

· Reliability 
· A computer is a reliable machine. 
· Modern electronic components have long lives. 
· Computers are designed to make maintenance easy. 

· Automation 
· Computer is an automatic machine. 
· Automation means ability to perform the given task automatically. 

Once a program is given to computer i.e. stored in computer memory, the program and instruction can control 
the program execution without human interaction. 

· Reduction in Paper Work 
· The use of computers for data processing in an organization leads to reduction in paper work and 

results in speeding up a process. 
· As data in electronic files can be retrieved as and when required, the problem of maintenance of 

large number of paper files gets reduced. 

· Reduction in Cost 
· Though the initial investment for installing a computer is high but it substantially reduces the cost 

of each of its transaction. 
 

Ø Disadvantages 
Following list demonstrates the disadvantages of computers:- 

· No I.Q 
· A computer is a machine that has no intelligence to perform any task. 
· Each instruction has to be given to computer. 
· A computer cannot take any decision on its own. 

· Dependency 
· It functions as per a user’s instruction, so it is fully dependent on human being. 

· Environment 
· The operating environment of computer should be dust free and suitable. 

· No Feeling 
· Computers have no feelings or emotions. 
· It cannot make judgment based on feeling, taste, experience, and knowledge unlike a human 

being. 
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Following list demonstrates various applications of computers 

Ø Business 
A computer has high speed of calculation, diligence, accuracy, reliability, or versatility which made it an integrated 
part in all business organisations. 

Computer is used in business organisations for:

· Payroll calculations 
· Budgeting 
· Sales analysis 
· Financial forecasting 
· Managing employees database
· Maintenance of stocks etc. 

 
 

Ø Banking 
Today banking is almost totally dependent on computer.

Banks provide following facilities: 

· Banks provide online accounting facility, which includes 
current balances, deposits, overdrafts, interest charges, 
shares, and trustee records. 

· ATM machines are making it even easier for customers to 
deal with banks. 
 
 
 
 
 

Ø Insurance 
Insurance companies are keeping all records up
computers. The insurance companies, finance houses and stock broking firms 
are widely using computers for their concerns.

Insurance companies are maintaining a database of all clients with information 
showing 

· procedure to continue with policies
· starting date of the policies 
· next due installment of a policy
· maturity date 
· interests due 
· survival benefits 
· bonus 
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Following list demonstrates various applications of computers  

A computer has high speed of calculation, diligence, accuracy, reliability, or versatility which made it an integrated 

organisations for: 

Managing employees database 

Today banking is almost totally dependent on computer. 

provide online accounting facility, which includes 
current balances, deposits, overdrafts, interest charges, 

 
ATM machines are making it even easier for customers to 

keeping all records up-to-date with the help of 
computers. The insurance companies, finance houses and stock broking firms 
are widely using computers for their concerns. 

Insurance companies are maintaining a database of all clients with information 

procedure to continue with policies 

next due installment of a policy 
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Ø Education 
The computer has provided a lot of facilities in the education system.

· The computer provides a tool in the education system 
known as CBE (Computer Based Education).

· CBE involves control, delivery, and evaluation of learning.
· The computer education is rapidly increasing the graph of 

number of computer students
· There are number of methods in which 

institutions can use computer to educate the students.
· It is used to prepare a database about performance of a 

student and analysis is carried out on this basis.

Ø Marketing 
In marketing, uses of computer are following:

· Advertising - With computers, advertising professionals create art and 
graphics, write and revise copy, and print and disseminate ads with the 
goal of selling more products.

· At Home Shopping - Home shopping has been made possible through 
use of computerised catalogues that provide
information and permit direct entry of orders to be filled by the 
customers. 

Ø Health Care 
Computers have become important part in hospitals, labs, and 
dispensaries. The computers are being used in hospitals to keep the 
record of patients and medicines. It is also used in scanning and 
diagnosing different diseases. ECG, EEG, Ultrasounds and CT Scans etc. 
are also done by computerised machines. 

Some major fields of health care in which computers are used are:

· Diagnostic System - Computers are used to collect data 
and identify cause of illness. 

· Lab-diagnostic System - All tests can be done and reports are prepared by computer.
· Patient Monitoring System -

Cardiac Arrest, ECG etc. 
· Pharma Information System

effects etc. 
· Surgery: Nowadays, computers are also used in performing surgery.

Ø Engineering Design 
Computers are widely used in Engineering purpose.

One of major areas is CAD (Computer aided design).that provides creation 
and modification of images. Some fields are: 

 Structural Engineering - Requires stress and strain analysis for design 
Ships, Buildings, Budgets, Airplanes etc. 
 Industrial Engineering - Computers deal with design, implementation 
and improvement of integrated systems of people, materials and 
equipments. 
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 Architectural Engineering - Computers help in planning towns, designing buildings, determining a range of
buildings on a site using both 2D and 3D drawings.

Ø Military 
Computers are largely used in defence. modern tanks, missiles, weapons etc. 
Military also employs computerised control systems. Some military areas where a 
computer has been used are: 

· Missile Control 
· Military Communication 
· Military Operation and Planning
· Smart Weapons 

Ø Communication 
Communication means to convey a message, an idea, a picture or speech that is received and understood clearly 
and correctly by the person for whom it is meant for. Some mai

· E-mail 
· Chatting 
· Usenet 
· FTP 
· Telnet 
· Video-conferencing 

Ø Government 
Computers play an important role in government. Some major fields in this 

· Budgets 
· Sales tax department 
· Income tax department 
· Male/Female ratio 
· Computerization of voters lists
· Computerization of driving licensing system
· Computerization of PAN card
· Weather forecasting 
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Ø Computer Generations 

Generation in computer terminology is a change in technology a computer is/was being 
generation term was used to distinguish between varying hardware technologies. But nowadays, generation 
includes both hardware and software, which together make up an entire computer system.

          There are totally five computer generations known till date. Each generation has been discussed in detail 
along with their time period and characteristics. Here approximate dates against each generations have been 
mentioned which are normally accepted. 

· First Generation 
 The period of first generation was 1946
generation used vacuum tubes as the basic components for memory and 
circuitry for CPU (Central Processing Unit). These tubes, like electric bulbs, 
produced a lot of heat and were prone to frequent fusing of the installations, 
therefore, were very expensive and could be afforded only by very large 
organisations. In this generation mainly batch processing operating system were 
used. Punched cards, paper tape, and magnetic tape were used as input and 
output devices. The computers in this ge
programming language. 

The main features of first generation are: 

· Vacuum tube technology 
· Unreliable 
· Supported machine language only
· Very costly 
· Generated lot of heat 

SL No 

1 

First Generation 

The period of first generation: 1946

2 

Second Generation 

The period of second generation: 1959

3 

Third Generation 

The period of third generation: 1965

4 

Fourth Generation 

The period of fourth generation: 1971

5 

Fifth Generation 

The period of fifth generation: 1980
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Generation in computer terminology is a change in technology a computer is/was being used. Initially, the 
generation term was used to distinguish between varying hardware technologies. But nowadays, generation 
includes both hardware and software, which together make up an entire computer system. 

nerations known till date. Each generation has been discussed in detail 
along with their time period and characteristics. Here approximate dates against each generations have been 

The period of first generation was 1946-1959. The computers of first 
generation used vacuum tubes as the basic components for memory and 
circuitry for CPU (Central Processing Unit). These tubes, like electric bulbs, 
produced a lot of heat and were prone to frequent fusing of the installations, 

were very expensive and could be afforded only by very large 
organisations. In this generation mainly batch processing operating system were 
used. Punched cards, paper tape, and magnetic tape were used as input and 
output devices. The computers in this generation used machine code as 

Supported machine language only 

Generation and Description 

The period of first generation: 1946-1959. Vacuum tube based. 

The period of second generation: 1959-1965. Transistor based. 

The period of third generation: 1965-1971. Integrated Circuit based. 

The period of fourth generation: 1971-1980. VLSI microprocessor based. 

The period of fifth generation: 1980-onwards.ULSI microprocessor based 
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· Slow input and output devices 
· Huge size 
· Need of A.C. 
· Non-portable 
· Consumed lot of electricity 

Some computers of this generation were: 

· ENIAC 
· EDVAC 
· UNIVAC 
· IBM-701 
· IBM-650 

· Second Generation 
The period of second generation was 1959-1965. In this generation transistors were used that were cheaper, 
consumed less power, more compact in size, more reliable and faster than the first generation machines made of 
vacuum tubes. In this generation, magnetic cores were used as primary memory and magnetic tape and magnetic 
disks as secondary storage devices. In this generation assembly language and high-level programming languages 
like FORTRAN, COBOL were used. The computers used batch processing and multiprogramming operating system. 

The main features of second generation are: 

· Use of transistors 
· Reliable in comparison to first generation computers 
· Smaller size as compared to first generation computers 
· Generated less heat as compared to first generation 

computers 
· Consumed less electricity as compared to first generation 

computers 
· Faster than first generation computers 
· Still very costly 
· A.C. needed 
· Supported machine and assembly languages 

 
Some computers of this generation were:  
 

· IBM 1620 
· IBM 7094 
· CDC 1604 
· CDC 3600 
· UNIVAC 1108 

 

· Third Generation 
The period of third generation was 1965-1971. The computers of third 
generation used integrated circuits (IC's) in place of transistors. A single IC 
has many transistors, resistors and capacitors along with the associated 
circuitry. The IC was invented by Jack Kilby. This development made 
computers smaller in size, reliable and efficient. In this generation remote 
processing, time-sharing, multi-programming operating system were used. 
High-level languages (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68 etc.) were used during this 
generation. 
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The main features of third generation are: 

· IC used 
· More reliable in comparison to previous two generations
· Smaller size 
· Generated less heat 
· Faster 
· Lesser maintenance 
· Still costly 
· A.C needed 
· Consumed lesser electricity 

 
Supported high-level language Some computers of this generation were

· IBM-360 series 
· Honeywell-6000 series 
· PDP(Personal Data Processor)
· IBM-370/168 
· TDC-316 

· Fourth Generation 
The period of fourth generation was 1971-
Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors and other circuit elements and their 
associated circuits on a single chip made it possible to have microcomputers of fourth generation. Fourth 
generation computers became more powerful, compact, reliable, and affordable. As a result, it gave rise to 
personal computer (PC) revolution. In this generation time sharing, real time, networks, distributed operating 
system were used. All the high-level language

The main features of fourth generation are: 

· VLSI technology used 
· Very cheap 
· Portable and reliable 
· Use of PC's 
· Very small size 
· Pipeline processing 
· No A.C. needed 
· Concept of internet was introduced
· Great developments in the fields of networks
· Computers became easily available

Some computers of this generation were: 

· DEC 10 
· STAR 1000 
· PDP 11 
· CRAY-1(Super Computer) 
· CRAY-X-MP(Super Computer)

· Fifth Generation 
The period of fifth generation is 1980-till dat
Large Scale Integration) technology, resulting in the production of microprocessor chips having ten million 
electronic components. This generation is based on parallel processing hardware a
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level language Some computers of this generation were 
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-1980. The computers of fourth generation used Very Large Scale 
Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors and other circuit elements and their 
associated circuits on a single chip made it possible to have microcomputers of fourth generation. Fourth 

ion computers became more powerful, compact, reliable, and affordable. As a result, it gave rise to 
personal computer (PC) revolution. In this generation time sharing, real time, networks, distributed operating 

level languages like C, C++, DBASE etc. were used in this generation.

 

Concept of internet was introduced 
Great developments in the fields of networks 
Computers became easily available 

MP(Super Computer) 

till date. In the fifth generation, the VLSI technology became ULSI (Ultra 
Large Scale Integration) technology, resulting in the production of microprocessor chips having ten million 
electronic components. This generation is based on parallel processing hardware and AI (Artificial Intelligence) 
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software. AI is an emerging branch in computer science, which interprets means and method of making 
computers think like human beings. All the high-level languages like C and C++, Java, .Net etc. are used in this 
generation. 

AI includes: 

· Robotics 

· Neural networks 
· Game Playing 
· Development of expert systems to make decisions in real life situations. 
· Natural language understanding and generation. 

The main features of fifth generation are: 

· ULSI technology 
· Development of true artificial intelligence 
· Development of Natural language processing 
· Advancement in Parallel Processing 
· Advancement in Superconductor technology 
· More user friendly interfaces with multimedia features 
· Availability of very powerful and compact computers at cheaper 

rates  

Some computer types of this generation are: 

· Desktop 
· Laptop 
· NoteBook 
· UltraBook 
· ChromeBook 

· Types Computers can be broadly classified by their speed and computing power. 

 

S.L. No Type Specification 

1 PC(personal Computer) It is a single user computer system having moderately 
powerful microprocessor 

2 WorkStation 
It is also a single user computer system which is similar 

to personal computer but have more powerful 
microprocessor. 

3 Mini Computer It is a multi-user computer system which is capable of 
supporting hundreds of users simultaneously 

4 Main Frame 
It is a multi-user computer system which is capable of 

supporting hundreds of users simultaneously. Software 
technology is different from minicomputer. 

5 Supercomputer It is an extremely fast computer which can execute 
hundreds of millions of instructions per second. 
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· PC (Personal Computer) 

A PC can be defined as a small, relatively inexpensive computer designed 
for an individual user. PCs are based on the microprocessor technology that 
enables manufacturers to put an entire CPU on one chip. Businesses use 
personal computers for word processing, accounting, desktop publishing, 
and for running spreadsheet and database man
home, the most popular use for personal computers is playing games and 
surfing Internet. 

               Although personal computers are designed as single
together to form a network. In terms of power, now
same computing power and graphics capability as low
and Dell. 

· Workstation 

Workstation is a computer used for engineering
desktop publishing, software development, and other such types of 
applications which require a moderate amount of computing power and 
relatively high quality graphics capabilities. 

Workstations generally come with a large, high
large amount of RAM, inbuilt network support, and a graphical user 
interface. Most workstations also have a mass storage device such as a 
disk drive, but a special type of workstation, called a diskless workstation, 
comes without a disk drive. 

Common operating systems for workstations are UNIX and Windows NT. 
Like PC, Workstations are also single-user computers like PC but are typically linked together to form a local
network, although they can also be used as stand

· Minicomputer 
 

It is a midsize multi-processing system capable of supporting up to 250 users 
simultaneously. 

 

 

 

 

· Mainframe 
Mainframe is very large in size and is an expensive computer capable of 
supporting hundreds or even thousands of users 
Mainframe executes many programs concurrently and supports many 
simultaneous execution of programs. 
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individual user. PCs are based on the microprocessor technology that 

enables manufacturers to put an entire CPU on one chip. Businesses use 
personal computers for word processing, accounting, desktop publishing, 
and for running spreadsheet and database management applications. At 
home, the most popular use for personal computers is playing games and 

Although personal computers are designed as single-user systems, these systems are normally linked 
In terms of power, now-a-days High-end models of the Macintosh and PC offer the 

same computing power and graphics capability as low-end workstations by Sun Microsystems, Hewlett

Workstation is a computer used for engineering applications (CAD/CAM), 
desktop publishing, software development, and other such types of 
applications which require a moderate amount of computing power and 

Workstations generally come with a large, high-resolution graphics screen, 
large amount of RAM, inbuilt network support, and a graphical user 
interface. Most workstations also have a mass storage device such as a 
disk drive, but a special type of workstation, called a diskless workstation, 

Common operating systems for workstations are UNIX and Windows NT. 
user computers like PC but are typically linked together to form a local

network, although they can also be used as stand-alone systems. 

processing system capable of supporting up to 250 users 

Mainframe is very large in size and is an expensive computer capable of 
supporting hundreds or even thousands of users simultaneously. 
Mainframe executes many programs concurrently and supports many 
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· Supercomputer 

Supercomputers are one of the fastest computers currently available. Supercomputers are very 
expensive and are employed for specialized applications that require immense amount of 
mathematical calculations (number crunching). For example, weather forecasting, scientific 
simulations, (animated) graphics, fluid dynamic calculations, nuclear energy research, 
electronic design, and analysis of geological data (e.g. in petrochemical prospecting).

 

All  types  of  computers  follow  a  same  basic  logical  structure  and  perform  the  following  five  basic 
operations for converting raw input data into information 

S.L. No Type 

1 Take Input 
It is a single user computer system having moderately powerful 

2 Store Data It is also a single user computer system which is similar to personal 

3 Processing Data Performing arithmetic, and logical operations on data in order to convert 

4 Output Information The process of producing useful information or results for the user, such as 

5 Control the workflow Directs the manner and sequence in which all of the above operations are 

 

 

 

 

 

 

· Input Unit 
This unit contains devices with the help of which we enter data into computer. This unit makes link between 
and computer. The input devices translate the information into the form understandable by computer.

· CPU (Central Processing Unit) 
CPU is considered as the brain of the computer. CPU performs all types of data processing operations. It stores 
data, intermediate results and instructions(program).It controls the operation of all part of computer.
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Supercomputers are one of the fastest computers currently available. Supercomputers are very 
for specialized applications that require immense amount of 

mathematical calculations (number crunching). For example, weather forecasting, scientific 
simulations, (animated) graphics, fluid dynamic calculations, nuclear energy research, 

and analysis of geological data (e.g. in petrochemical prospecting). 

v Components 

All  types  of  computers  follow  a  same  basic  logical  structure  and  perform  the  following  five  basic 
operations for converting raw input data into information useful to their users 

Specification 

It is a single user computer system having moderately powerful 
microprocessor 

It is also a single user computer system which is similar to personal 
computer but have more powerful microprocessor.

Performing arithmetic, and logical operations on data in order to convert 
them into useful information 

The process of producing useful information or results for the user, such as 
a printed report or visual display. 

Directs the manner and sequence in which all of the above operations are 
performed. 

This unit contains devices with the help of which we enter data into computer. This unit makes link between 
and computer. The input devices translate the information into the form understandable by computer.

CPU is considered as the brain of the computer. CPU performs all types of data processing operations. It stores 
ermediate results and instructions(program).It controls the operation of all part of computer.
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CPU itself has following three components 

· ALU(Arithmetic Logic Unit) 
· Memory Unit 
· Control Unit 

· Output Unit 
Output unit consists of devices with the help of which we get the information from computer. This unit is a link 
between computer and users. Output devices translate the computer's output into the form understandable by 
users. 

 

v Input Devices 
 

· Following are few of the important input devices which are used in a computer: 
· Keyboard 
· Mouse 
· Joy Stick 
· Light pen 
· Track Ball 
· Scanner 
· Graphic Tablet 
· Microphone 
· Magnetic Ink Card Reader(MICR) 
· Optical Character Reader(OCR) 
· Bar Code Reader 
· Optical Mark Reader(OMR) 

 

· Keyboard 
Keyboard is the most common and very popular input device which helps 
in inputting data to the computer. The layout of the keyboard is like that 
of traditional typewriter, although there are some additional keys 
provided for performing additional functions.  

The keys on the keyboard are as follows: 

S.L. No Keys Description 

1 Typing Keys 
These keys include the letter keys (A-Z) and digit keys (0-

9) which generally give same layout as that of 
typewriters 

2 Numeric Keypad 

It is used to enter numeric data or cursor movement. 
Generally, it consists of a set of 17 keys that are laid out 

in the same configuration used by most adding machines 
and calculators. 

3 Function Keys 

The twelve function keys are present on the keyboard 
which are arranged in a row at the top of the keyboard. 
Each function key has unique meaning and is used for 

some specific purpose. 
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4 Control keys 

5 Special Purpose Keys 
 

· Mouse 
Mouse is most popular pointing device. It is a very famous cursor
having a small palm size box with a round ball at its base which senses the 
movement of mouse and sends corresponding signals to CPU when the mouse 
buttons are pressed. 

Generally it has two buttons called left and right button and a wheel is present 
between the buttons. Mouse can be used to control the position of cursor on 
screen, but it cannot be used to enter text into the computer.

· Advantages 
· Easy to use 
· Not very expensive 
· Moves the cursor faster than the 

· Joystick 
Joystick is also a pointing device which is used to move cursor position on a monitor 
screen. It is a stick having a spherical ball at its both lower and upper ends. The lower 
spherical ball moves in a socket. The joystick can be moved in all four directions.

The function of joystick is similar to that of a mouse. It is mainly used in Computer Aided 
Designing(CAD) and playing computer games.

· Light Pen 

Light pen is a pointing device which is similar to a pen. It is used to
menu item or draw pictures on the monitor screen. It consists of a photocell and an 
optical system placed in a small tube. When the tip of a light pen is moved over the 
monitor screen and pen button is pressed, its photocell sensing ele
screen location and sends the corresponding signal to the CPU.

· Track Ball 
Track ball is an input device that is mostly used in notebook or laptop computer, instead 
of a mouse. This is a ball which is half inserted and by moving fingers on 
be moved. Since the whole device is not moved, a track ball requires less space than a 
mouse. A track ball comes in various shapes like a ball, a button and a square.
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four directional arrow keys. Control keys also include 

Home,End, Insert, Delete, Page Up,Page Down, 
Control(Ctrl), Alternate(Alt), Escape(Esc).

Keyboard also contains some special purpose keys such 
as Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and 

Print Screen. 
 

. It is a very famous cursor-control device 
having a small palm size box with a round ball at its base which senses the 
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d right button and a wheel is present 
between the buttons. Mouse can be used to control the position of cursor on 
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Moves the cursor faster than the arrow keys of keyboard. 

Joystick is also a pointing device which is used to move cursor position on a monitor 
screen. It is a stick having a spherical ball at its both lower and upper ends. The lower 

can be moved in all four directions. 

The function of joystick is similar to that of a mouse. It is mainly used in Computer Aided 
Designing(CAD) and playing computer games. 

Light pen is a pointing device which is similar to a pen. It is used to select a displayed 
menu item or draw pictures on the monitor screen. It consists of a photocell and an 
optical system placed in a small tube. When the tip of a light pen is moved over the 
monitor screen and pen button is pressed, its photocell sensing element detects the 
screen location and sends the corresponding signal to the CPU. 

Track ball is an input device that is mostly used in notebook or laptop computer, instead 
of a mouse. This is a ball which is half inserted and by moving fingers on ball, pointer can 
be moved. Since the whole device is not moved, a track ball requires less space than a 
mouse. A track ball comes in various shapes like a ball, a button and a square. 
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· Scanner 
Scanner is an input device which works more like a photocopy 
information is available on a paper and it is to be transferred to the hard disc of the computer for 
further manipulation. Scanner captures images from the source which are then converted into 
the digital form that can be stored on the disc. These images can be edited before they are 
printed. 

· Digitizer 
Digitizer is an input device which converts analog information into digital form. Digitizer 
can convert a signal from the television or camera into a series of numbers that 
be stored in a computer. They can be used by the computer to create a picture of 
whatever the camera had been pointed at. Digitizer is also known as Tablet or Graphics 
Tablet because it converts graphics and pictorial data into binary inputs. A graph
tablet as digitizer is used for doing fine works of drawing and image manipulation 
applications. 

 

· Microphone 
Microphone is an input device to input sound that is then stored in digital form. The 
microphone is used for various applications like adding 
for mixing music. 

· Magnetic Ink Card Reader(MICR) 
MICR input device is generally used in banks because of a large number of cheques to be 
processed every day. The bank's code number and cheque number are printed on the
with a special type of ink that contains particles of magnetic material that are machine 
readable. This reading process is called Magnetic Ink Character Recognition (MICR). The main 
advantages of MICR is that it is fast and less error prone.

 

· Optical Character Reader(OCR) 
OCR is an input device used to read a printed text. OCR scans text optically character by 
character, converts them into a machine readable code and stores the text on the system 
memory. 

· Bar Code Readers 
Bar Code Reader is a device used for reading bar coded data (data in form of light and 
dark lines). Bar coded data is generally used in labelling goods, numbering the books 
etc. It may be a hand held scanner or may be embedded in a stationary scanner. Bar 
Code Reader scans a bar code image, converts it into an alphanumeric value which is 
then fed to the computer to which bar code reader is connected.

 

· Optical Mark Reader(OMR) 
OMR is a special type of optical scanner used to recognize the type of mark 
made by pen or pencil. It is used where one out of a few alternatives is to be 
selected and marked. It is specially used for checking the answer sheets of 
examinations having multiple choice questions.
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· Following are few of the important output devices which are used in a

· Monitors 
· Graphic Plotter 
· Printer 

· Monitors 
Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It forms 
images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of 
upon the number of pixels. 

There are two kinds of viewing screen used for monitors.

· Cathode-Ray Tube (CRT) 
· Flat- Panel Display 

· Cathode-Ray Tube (CRT) Monitor 
The CRT display is made up of small picture elements called pixels. The smaller
better the image clarity, or resolution. It takes more than one illuminated pixel to form 
whole character, such as the letter ‘e’in the word help.

A finite number of characters can be displayed on a screen at once. The screen can be 
divided into a series of character boxes - fixed location on the screen where a standard 
character can be placed. Most screens are capable of displaying 80 characters of data 
horizontally and 25 lines vertically. There are some disadvantages of CRT

· Large in Size 
· High power consumption 

 

· Flat-Panel Display Monitor 

 
The flat-panel display refers to a class of video devices that have reduced volume, 
weight and power requirement in comparison to the CRT. You can hang them on 
walls or wear them on your wrists. Current uses of flat
calculators, videogames, monitors, laptop computer, graphics display.

 

The flat-panel display is divided into two categories

· Emissive Displays - The emissive displays are devices that convert electrical energy into 
plasma panel and LED(Light-Emitting Diodes). 

· Non-Emissive Displays - The Non-emissive displays use optical effects to convert sunlight or light from some 
other source into graphics patterns. Example is LCD(Liquid
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Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It forms 
images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the image depends 

There are two kinds of viewing screen used for monitors. 

The CRT display is made up of small picture elements called pixels. The smaller the pixels, the 
better the image clarity, or resolution. It takes more than one illuminated pixel to form 
whole character, such as the letter ‘e’in the word help. 

A finite number of characters can be displayed on a screen at once. The screen can be 
fixed location on the screen where a standard 

character can be placed. Most screens are capable of displaying 80 characters of data 
horizontally and 25 lines vertically. There are some disadvantages of CRT 

panel display refers to a class of video devices that have reduced volume, 
weight and power requirement in comparison to the CRT. You can hang them on 

uses of flat-panel displays include 
calculators, videogames, monitors, laptop computer, graphics display. 

panel display is divided into two categories 

The emissive displays are devices that convert electrical energy into 
Emitting Diodes). 

emissive displays use optical effects to convert sunlight or light from some 
other source into graphics patterns. Example is LCD(Liquid-Crystal Device) 
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Ø Printers 
 

Printer is an output device, which is used to print information on paper. 

There are two types of printers 

· Impact Printers 
· Non-Impact Printers 

 

· Impact Printers 
 

The impact printers print the characters by striking them on the ribbon which is then pressed on the paper. 
Characteristics of Impact Printers are the following 

 
· Very low consumable costs 
· Very noisy 
· Useful for bulk printing due to low cost 
· There is physical contact with the paper to produce an image These printers are of two types 

o Character printers 
o Line printers 

 

· Character Printers 

 
Character printers are the printers which print one character at a time. 

These are further divided into two types 

· Dot Matrix Printer(DMP) 
· Daisy Wheel 

 

· Dot Matrix Printer 

 
In the market one of the most popular printers is Dot Matrix Printer. These 
printers are popular because of their ease of printing and economical price. 
Each character printed is in form of pattern of dots and head consists of a 
Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) which come out to form a 
character that is why it is called Dot Matrix Printer. 
Advantages 

· Inexpensive 
· Widely Used 
· Other language characters can be printed 
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Disadvantages 

· Slow Speed 
· Poor Quality 

· Daisy Wheel 
Head is lying on a wheel and pins corresponding to characters 
petals of Daisy (flower name) that is why it is called Daisy Wheel Printer. 
These printers are generally used for word-processing in offices which 
require a few letters to be sent here and there with very nice quality.

Advantages 

· More reliable than DMP 
· Better quality 
· The fonts of character can be easily changed

Disadvantages 

· Slower than DMP 
· Noisy 
· More expensive than DMP 

 

· Line Printers 
 

Line printers are the printers which print one line at a time

Line printers are the printers which print one 

These are of further two types 

 
· Drum Printer 
· Chain Printer 

 

· Drum Printer 
 

This printer is like a drum in shape so it is called drum printer. The surface of drum is divided into number of 
tracks. Total tracks are equal to size of paper i.e. 
character set is embossed on track. The different character sets available in the market are 48 character set, 64 
and 96 characters set. One rotation of drum prints one line. Drum printers a
2000 lines per minute. 

Advantages 

· Very high speed 
Disadvantages 

· Very expensive 
· Characters’fonts cannot be changed

 

· Chain Printer 
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Head is lying on a wheel and pins corresponding to characters are like 
petals of Daisy (flower name) that is why it is called Daisy Wheel Printer. 

processing in offices which 
require a few letters to be sent here and there with very nice quality. 

The fonts of character can be easily changed 

Line printers are the printers which print one line at a time. 

Line printers are the printers which print one line at a time. 

This printer is like a drum in shape so it is called drum printer. The surface of drum is divided into number of 
tracks. Total tracks are equal to size of paper i.e. for a paper width of 132 characters, drum will have 132 tracks. A 
character set is embossed on track. The different character sets available in the market are 48 character set, 64 
and 96 characters set. One rotation of drum prints one line. Drum printers are fast in speed and can print 300 to 

Characters’fonts cannot be changed 
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In this printer, chain of character sets are used so it is called Chain Printer. A 
64, or 96 characters. 

Advantages 

· Character fonts can easily be changed.
· Different languages can be used with the same printer.

 

Disadvantages 

· Noisy 
 

· Non-impact Printers 
 

Non-impact printers print the characters without 
they are also called as Page Printers. 

 

These printers are of two types 

· Laser Printers 
· Inkjet Printers 

Characteristics of Non-impact Printers 

· Faster than impact printers. 
· They are not noisy. 
· High quality. 
· Support many fonts and different character size.

 

· Laser Printers 
 

These are non-impact page printers. They use laser lights to produce the dots 
needed to form the characters to be printed on a page.

Advantages 

· Very high speed 
· Very high quality output 
· Give good graphics quality 
· Support many fonts and different character size

 
Disadvantages 

· Expensive. 
· Cannot be used to produce multiple copies of a document in a single printing.

· Inkjet Printers 
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In this printer, chain of character sets are used so it is called Chain Printer. A standard character set may have 48, 

Character fonts can easily be changed. 
Different languages can be used with the same printer. 

impact printers print the characters without using ribbon. These printers print a complete page at a time so 

 

Support many fonts and different character size. 

impact page printers. They use laser lights to produce the dots 
needed to form the characters to be printed on a page. 

Support many fonts and different character size 

Cannot be used to produce multiple copies of a document in a single printing. 
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Inkjet printers are non-impact character printers based on a relatively new technology. They print characters by 
spraying small drops of ink onto paper. Inkjet printers produce high quality output with presentable features.
 
They make less noise because no hammering is done and these have many style
printing modes available. Colour printing is also possible. Some models of Inkjet 
printers can produce multiple copies of printing also.
Advantages 

· High quality printing 
· More reliable 

 
Disadvantages 

· Expensive as cost per page is high
· Slow as compared to laser printer

 
 

v

A memory is just like a human brain. It is used to store data and instructions. Computer memory is the storage 
space in computer where data is to be processed and instructions required for processing are stored. The 
memory is divided into large number of small parts called cells. Each location or cell has a unique address which 
varies from zero to memory size minus one. For example if computer has 64k words, then this memory unit has 
64 * 1024=65536 memory locations. The address 

Memory is primarily of three types 

· Cache Memory 
· Primary Memory/Main Memory
· Secondary Memory 

 

Ø Cache Memory 

Cache memory is a very high speed semiconductor memory which can speed up CPU. It acts as a buffer between 
the CPU and main memory. It is used to hold those parts of data and program which are most frequently used by 
CPU. The parts of data and programs are transferred from disk to cache memory by operating system, from 
where CPU can access them. 

Advantages 

The advantages of cache memory are as follows

· Cache memory is faster than main memory.
· It consumes less access time as compared to main memory.
· It stores the program that can be executed within a short 

period of time. 
· It stores data for temporary use.
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memory is just like a human brain. It is used to store data and instructions. Computer memory is the storage 
space in computer where data is to be processed and instructions required for processing are stored. The 

vided into large number of small parts called cells. Each location or cell has a unique address which 
varies from zero to memory size minus one. For example if computer has 64k words, then this memory unit has 
64 * 1024=65536 memory locations. The address of these locations varies from 0 to 65535. 

Primary Memory/Main Memory 

Cache memory is a very high speed semiconductor memory which can speed up CPU. It acts as a buffer between 
the CPU and main memory. It is used to hold those parts of data and program which are most frequently used by 
CPU. The parts of data and programs are transferred from disk to cache memory by operating system, from 

advantages of cache memory are as follows 

Cache memory is faster than main memory. 
It consumes less access time as compared to main memory. 
It stores the program that can be executed within a short 

It stores data for temporary use. 
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Disadvantages 

The disadvantages of cache memory are as follows

· Cache memory has limited capacity.
· It is very expensive. 

Ø Primary Memory (Main Memory)

Primary memory holds only those data and instructions on which computer is currently working. It has limited 
capacity and data is lost when power is switched off. It is generally made up of semiconductor device. These 
memories are not as fast as registers. The data and instruction required to be processed reside in main memory. It 
is divided into two subcategories RAM and ROM.

Characteristics of Main Memory 

· These are semiconductor memories.
· It is known as main memory. 
· Usually volatile memory. 
· Data is lost in case power is switched off.
· It is working memory of the computer.
· Faster than secondary memories.
· A computer cannot run without primary memory.

 
 

Ø Secondary Memory 

This type of memory is also known as external memory or non
than main memory. These are used for storing data/Information permanently. CPU 
directly does not access these memories instead they are accessed via input
routines. Contents of secondary memories are first transferred to main memory, 
and then CPU can access it. For example: disk, CD

Characteristic of Secondary Memory 

· These are magnetic and optical 
· It is known as backup memory.
· It is non-volatile memory. 
· Data is permanently stored even if power is switched off.
· It is used for storage of data in a computer.
· Computer may run without secondary memory.
· Slower than primary memories.

 
 

v Random 

RAM (Random Access Memory) is the internal memory of the CPU for storing data, program and program result. 
It is read/write memory which stores data until the machine is working. As soon as the machine is switched off, 
data is erased. 

B.C.Roy Computer Literacy Mission 

 

The disadvantages of cache memory are as follows 

Cache memory has limited capacity. 

rimary Memory (Main Memory) 

Primary memory holds only those data and instructions on which computer is currently working. It has limited 
capacity and data is lost when power is switched off. It is generally made up of semiconductor device. These 
memories are not as fast as registers. The data and instruction required to be processed reside in main memory. It 

s RAM and ROM. 

These are semiconductor memories. 
 

Data is lost in case power is switched off. 
It is working memory of the computer. 
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This type of memory is also known as external memory or non-volatile. It is slower 
than main memory. These are used for storing data/Information permanently. CPU 

es instead they are accessed via input-output 
routines. Contents of secondary memories are first transferred to main memory, 
and then CPU can access it. For example: disk, CD-ROM, DVD etc. 

These are magnetic and optical memories. 
It is known as backup memory. 

Data is permanently stored even if power is switched off. 
It is used for storage of data in a computer. 
Computer may run without secondary memory. 
Slower than primary memories. 

Random Access Memory 

RAM (Random Access Memory) is the internal memory of the CPU for storing data, program and program result. 
It is read/write memory which stores data until the machine is working. As soon as the machine is switched off, 
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Access time in RAM is independent of the address that is, each storage location 
inside the memory is as easy to reach as other locations and takes the same amount 
of time. Data in the RAM can be accessed randomly but it is very expensive. 

RAM is volatile, i.e. data stored in it is lost when we switch off the computer or if 
there is a power failure. Hence a backup uninterruptible power system (UPS) is often 
used with computers. RAM is small, both in terms of its physical size and in the 
amount of data it can hold. 

RAM is of two types 

· Static RAM (SRAM) 
· Dynamic RAM (DRAM) 

Ø Static RAM (SRAM) 
 

The word static indicates that the memory retains its contents as long as power is being supplied. However, data 
is lost when the power gets down due to volatile nature. SRAM chips use a matrix of 6-transistors and no 
capacitors. Transistors do not require power to prevent leakage, so SRAM need not have to be refreshed on a 
regular basis. 

Because of the extra space in the matrix, SRAM uses more chips than DRAM for the same amount of storage 
space, thus making the manufacturing costs higher. So SRAM is used as cache memory and has very fast access. 

Characteristic of the Static RAM 

· It has long life 
· There is no need to refresh 
· Faster 
· Used as cache memory 
· Large size 
· Expensive 
· High power consumption 

 

Ø Dynamic RAM (DRAM) 
 

DRAM, unlike SRAM, must be continually refreshed in order to maintain the data. This is done by placing the 
memory on a refresh circuit that rewrites the data several hundred times per second. DRAM is used for most 
system memory because it is cheap and small. All DRAMs are made up of memory cells which are composed of 
one capacitor and one transistor. 

Characteristics of the Dynamic RAM 

· It has short data lifetime 
· Need to be refreshed continuously 
· Slower as compared to SRAM 
· Used as RAM 
· Lesser in size 
· Less expensive 
· Less power consumption 
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v Read Only Memory 

ROM stands for Read Only Memory. The memory from which we can only read but 
cannot write on it. This type of memory is non-volatile. The information is stored 
permanently in such memories during manufacture. A ROM, stores such instructions 
that are required to start a computer. This operation is referred to as bootstrap. 
ROM chips are not only used in the computer but also in other electronic items like 
washing machine and microwave oven. 

Following are the various types of ROM 

Ø PROM (Programmable Read only Memory) 

PROM is read-only memory that can be modified only once by a user. The user buys a blank PROM and enters the 
desired contents using a PROM program. Inside the PROM chip there are small fuses which are burnt open during 
programming. It can be programmed only once and is not erasable. 

Ø EPROM (Erasable and Programmable Read Only Memory) 

The EPROM can be erased by exposing it to ultra-violet light for duration of up to 40 minutes. Usually, an EPROM 
eraser achieves this function. During programming, an electrical charge is trapped in an insulated gate region. The 
charge is retained for more than ten years because the charge has no leakage path. For erasing this charge, ultra-
violet light is passed through a quartz crystal window (lid). This exposure to ultra-violet light dissipates the charge. 
During normal use the quartz lid is sealed with a sticker. 

Ø EEPROM (Electrically Erasable and Programmable Read Only Memory) 

The EEPROM is programmed and erased electrically. It can be erased and reprogrammed about ten thousand 
times. Both erasing and programming take about 4 to 10 ms (milli second). In EEPROM, any location can be 
selectively erased and programmed. EEPROMs can be erased one byte at a time, rather than erasing the entire 
chip. Hence, the process of re-programming is flexible but slow. 

Ø Advantages of ROM  

The advantages of ROM are as follows: 

· Non-volatile in nature 
· These cannot be accidentally changed 
· Cheaper than RAMs 
· Easy to test 
· More reliable than RAMs 
· These are static and do not require refreshing 
· Its contents are always known and can be verified 
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v Motherboard 

The motherboard serves as a single platform to connect all of the parts of a 
computer together. A motherboard connects CPU, memory, hard drives, optical 
drives, video card, sound card, and other ports and expansion cards directly or via 
cables. It can be considered as the backbone of a computer. 

Ø Features of Motherboard 

A motherboard comes with following features: 

· Motherboard varies greatly in supporting various types of components. 
· Normally a motherboard supports a single type of CPU and few types of memories. 
· Video Cards, Hard disks, Sound Cards have to be compatible with motherboard to function 

properly. 
· Motherboards, cases and power supplies must be compatible to work properly together. 

Ø Popular Manufacturers 

· Intel 
· ASUS 
· AOpen 
· ABIT 
· Biostar 
· Gigabyte 
· MSI 

Ø Description of Motherboard 

The motherboard is mounted inside the case and is securely attached via small screws through pre-drilled holes. 
Motherboard contains ports to connect all of the internal components. It provides a single socket for CPU whereas 
for memory, normally one or more slots are available. Motherboards provide ports to attach floppy drive, hard 
drive, and optical drives via ribbon cables. Motherboard carries fans and a special port designed for power supply. 

There is a peripheral card slot in front of the motherboard using which video cards, sound cards and other 
expansion cards can be connected to motherboard. 

On the left side, motherboards carry a number of ports to connect monitor, printer, mouse, keyboard, speaker, 
and network cables. Motherboards also provide USB ports which allow compatible devices to be connected in 
plug-in/plug-out fashion for example, pen drive, digital cameras etc. 

v Memory Units 

Memory Unit (MU) is used to store data and all the results. For example, like brain in the human body, MU is used 
to store information.  
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Storage units are following: 

SL 
NO. 

UNIT DESCRIPTION 

1 Bit  
2 Nibble 1 Nibble=4 Bit 
3 Byte 1 Byte = 8 Bit 
4 Kilobyte (KB) 1 KB = 1024 Byte 
5 Megabyte (MB) 1 MB = 1024 KB 
6 GigaByte (GB) 1 GB = 1024 MB 
7 TeraByte (TB) 1 TB = 1024 GB 

 
 

v Hardware 

Hardware represents the physical and tangible components of a computer i.e. the components that can be seen 
and touched. 

Examples of Hardware are following: 

· Input devices -- keyboard, mouse etc. 
· Output devices -- printer, monitor etc. 
· Secondary storage devices -- Hard disk, CD, DVD etc. 
· Internal components -- CPU, motherboard, RAM etc. 

 

Ø Relationship between Hardware and Software 

· Hardware and software are mutually dependent on each other. Both of them must work together 
to make a computer produce a useful output. 

· Software cannot be utilized without supporting hardware. 
· Hardware without set of programs to operate upon cannot be utilized and is useless. 
· To get a particular job done on the computer, relevant software should be loaded into the 

hardware 
· Hardware is a one-time expense. 
· Software development is very expensive and is a continuing expense. 
· Different software applications can be loaded on hardware to run different jobs. 
· Software acts as an interface between the user and the hardware. 
· If hardware is the 'heart' of a computer system, then software is its 'soul'. Both are complimentary 

to each other. 
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v Software 

 

Software is a set of programs, which is designed to perform a well-defined function. A program is a sequence of 
instructions written to solve a particular problem. 

There are two types of software 

· System Software 
· Application Software 

 

Ø System Software 

The system software is collection of programs designed to operate, control, and extend the processing 
capabilities of the computer itself. System software are generally prepared by computer manufactures. These 
software products comprise of programs written in low-level languages which interact with the hardware at a 
very basic level. System software serves as the interface between hardware and the end users. 

 

Some examples of system software are Operating System, 
Compilers, Interpreter, Assemblers etc. 

 

Features of system software are as follows 

· Close to system 
· Fast in speed 
· Difficult to design 
· Difficult to understand 
· Less interactive 
· Smaller in size 
· Difficult to manipulate 
· Generally written in low-level language 

Ø Application Software 

Application software products are designed to satisfy a particular need of a particular environment. All software 
applications prepared in the computer lab can come under the category of Application software. 

Application software may consist of a single program, such as a 
Microsoft's notepad for writing and editing simple text. It may also 
consist of a collection of programs, often called a software 
package, which work together to accomplish a task, such as a 
spreadsheet package. 

Examples of Application software are following 

· Payroll Software 
· Student Record Software 
· Inventory Management Software 
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· Income Tax Software 
· Railways Reservation Software 
· Microsoft Office Suite Software 
· Microsoft Word 
· Microsoft Excel 
· Microsoft Powerpoint 

 

Features of application software are as follows 

· Close to user 
· Easy to design 
· More interactive 
· Slow in speed 
· Generally written in high-level language 
· Easy to understand 
· Easy to manipulate and use 
· Bigger in size and requires large storage space 

 
 

  
v Number System 

When we type some letters or words, the computer translates them in numbers as computers can understand 
only numbers. A computer can understand positional number system where there are only a few symbols called 
digits and these symbols represent different values depending on the position they occupy in the number. 

A value of each digit in a number can be determined using 

· The digit 
· The position of the digit in the number 
· The base of the number system (where base is defined as the total number of digits available in 

the number system). 

Ø Decimal Number System 

The number system that we use in our day-to-day life is the decimal number system. Decimal number system has 
base 10 as it uses 10 digits from 0 to 9. In decimal number system, the successive positions to the left of the 
decimal point represent units, tens, hundreds, thousands and so on. 

Each position represents a specific power of the base (10). For example, the decimal number 1234 consists of the 
digit 4 in the units position, 3 in the tens position, 2 in the hundreds position, and 1 in the thousands position, 
and its value can be written as 

(1x1000)+ (2x100)+ (3x10)+ (4xl) 
(1x103)+ (2x102)+ (3x101)+ (4xl00) 
1000 + 200 + 30 + 4 
1234 
As a computer programmer or an IT professional, you should understand the following number systems which 
are frequently used in computers. 
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Ø Binary Number System 

Characteristics of binary number system are as follows 

· Uses two digits, 0 and 1. 
· Also called base 2 number system 
· Each position in a binary number represents a 0 power of the base (2). Example 20 

· Last position in a binary number represents a x power of the base (2). Example 2x where x represents the last 
position - 1. 
 

Example 
Binary Number: 101012 
Calculating Decimal Equivalent: 
 
 

Step Binary Number Decimal Number 

Step 1 101012 ((1 x 24) + (0 x 23) + (1 x 22) + (0 x 21) + (1 x 20))10 

Step 2 101012 (16 + 0 + 4 + 0 + 1)10 

Step 3 101012 2110 
 

Note: 101012 is normally written as 10101. 

Ø Octal Number System 

Characteristics of octal number system are as follows 

· Uses eight digits, 0,1,2,3,4,5,6,7. 
· Also called base 8 number system 
· Each position in an octal number represents a 0 power of the base (8). Example 80 
· Last position in an octal number represents a x power of the base (8). Example 8x where x represents the last 

position - 1. 
 

Example 
Octal Number: 125708 

 

 

SL NO Number System and Description 
1 Binary Number System 

Base 2. Digits used: 0, 1 
2 Octal Number System 

Base 8. Digits used: 0 to 7 
3 Hexa Decimal Number System 

Base 16. Digits used: 0 to 9, Letters used: A- F 
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Calculating Decimal Equivalent: 

Step Octal Number Decimal Number 

step 1 125708 ((1 x 84) + (2 x 83) + (5 x 82) + (7 x 81) + (0 x 80))10 

Step 2 125708 (4096 + 1024 + 320 + 56 + 0)10 

Step 3 125708 549610 
 

Note: 125708 is normally written as 12570. 

Ø Hexadecimal Number System 

 

Characteristics of hexadecimal number system are as follows 

· Uses 10 digits and 6 letters, 0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F. 
· Letters represents numbers starting from 10. A = 10. B = 11, C = 12, D = 13, E = 14, F = 15. 
· Also called base 16 number system 
· Each position in a hexadecimal number represents a 0 power of the base (16). Example 160 
· Last position in a hexadecimal number represents a x power of the base (16). Example 16x where x represents 

the last position - 1.  

Example 

Hexadecimal Number: 19FDE16 

Calculating Decimal Equivalent: 

Step Binary Number Decimal Number 

Step 1 19FDE16 ((1 x 164) + (9 x 163) + (F x 162) + (D x 161) + (E x 160))10 

Step 2 19FDE16 ((1 x 164) + (9 x 163) + (15 x 162) + (13 x 161) + (14 x 160))10 

Step 3 19FDE16 (65536+ 36864 + 3840 + 208 + 14)10 

Step 4 19FDE16 10646210 
 

 

Note: 19FDE16 is normally written as 19FDE. 
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v Data and Information

Ø What is data? 

Data can be defined as a representation of facts, concepts or instructions
be suitable for communication, interpretation, or processing by human or electronic machine.

Data is represented with the help of characters like alphabets (A
,/,*,<,>,= etc.). 

 

 

 

 

 

 

Ø What is Information? 

Information is organised or classified data which has some meaningful values for the receiver. Information is the 
processed data on which decisions and actions are based.
 

For the decision to be meaningful, the processed 
following characteristics 

· Timely - Information should be available when required.
· Accuracy - Information should be accurate.
· Completeness - Information should be complete.

 

Ø Data Processing Cycle 

Data processing is the re-structuring or re-ordering of data by people or machine to increase their usefulness and 
add values for particular purpose. Data processing consists of basic steps input, processing and output. These 
three steps constitute the data processing cycle.

 

 

 

 

 

· Input - In this step the input data is prepared in some convenient form for processing. The form will depend 
on the processing machine. For example, when electronic computers are used, the input data could be 
recorded on any one of several types of inpu
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Data and Information 

ata can be defined as a representation of facts, concepts or instructions in a formalized manner which should 
be suitable for communication, interpretation, or processing by human or electronic machine. 

Data is represented with the help of characters like alphabets (A-Z, a-z), digits (0-9) or special characters(+,

Information is organised or classified data which has some meaningful values for the receiver. Information is the 
processed data on which decisions and actions are based. 

For the decision to be meaningful, the processed data must qualify for the 

Information should be available when required. 
Information should be accurate. 

Information should be complete. 

ordering of data by people or machine to increase their usefulness and 
add values for particular purpose. Data processing consists of basic steps input, processing and output. These 
three steps constitute the data processing cycle. 

In this step the input data is prepared in some convenient form for processing. The form will depend 
the processing machine. For example, when electronic computers are used, the input data could be 

recorded on any one of several types of input medium, such as magnetic disks, tapes and so on.
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in a formalized manner which should 
 

9) or special characters(+,-

Information is organised or classified data which has some meaningful values for the receiver. Information is the 

ordering of data by people or machine to increase their usefulness and 
add values for particular purpose. Data processing consists of basic steps input, processing and output. These 

In this step the input data is prepared in some convenient form for processing. The form will depend 
the processing machine. For example, when electronic computers are used, the input data could be 

t medium, such as magnetic disks, tapes and so on. 



                                      B.C.Roy Computer Literacy Mission

 

E-Book 
 

· Processing - In this step input data is changed to produce data in a more useful form. For example, pay
may be calculated from the time cards, or a summary of sales for the month may be calculated
orders.  

· Output -Here the result of the proceeding processing step are collected. The particular form of the output 
data depends on the use of the data. For example, output data may be pay

 

 

 

 

 

 

  
v

Ø What is a Computer Network?

A computer network is a system in which multiple computers are connected to each other to share information 
and resources. 

Ø Characteristics of a computer network

· Share Resources from one computer to another
· Create files and store them in one computer, access those files from the other computer(s) connected over 

the network 
· Connect a printer, scanner, or a fax machine to one computer within the network and let other computers of 

the network use the machines available over network.
Following is the list of Hardwares required to setup a computer network.

· Network Cables 
· Distributors 
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In this step input data is changed to produce data in a more useful form. For example, pay
may be calculated from the time cards, or a summary of sales for the month may be calculated

Here the result of the proceeding processing step are collected. The particular form of the output 
depends on the use of the data. For example, output data may be pay-checks for employees.

v Networking 

a Computer Network? 

computer network is a system in which multiple computers are connected to each other to share information 

Characteristics of a computer network 

Share Resources from one computer to another 
in one computer, access those files from the other computer(s) connected over 

Connect a printer, scanner, or a fax machine to one computer within the network and let other computers of 
the network use the machines available over network. 

ing is the list of Hardwares required to setup a computer network. 
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In this step input data is changed to produce data in a more useful form. For example, pay-checks 
may be calculated from the time cards, or a summary of sales for the month may be calculated from the sales 

Here the result of the proceeding processing step are collected. The particular form of the output 
checks for employees. 

computer network is a system in which multiple computers are connected to each other to share information 

in one computer, access those files from the other computer(s) connected over 

Connect a printer, scanner, or a fax machine to one computer within the network and let other computers of 
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· Routers 
· Internal Network Cards 
· External Network Cards 

Ø Network Cables 

Network cables are used to connect computers. The most commonly used cable is 
Category 5 cable RJ-45. 

 

Ø Distributors 

A computer can be connected to another one via a serial port but if we need to 
many computers to produce a network, this serial connection will not work. The solution is 
central body to which other computers, printers, scanners etc. can be connected and then this body will manage 
or distribute network traffic. 

Ø Router 

A router is a type of device which acts as the central point among computers and 
other devices that are part of a network. A router is equipped wit
ports and computers and other devices are connected to a router using network 
cables. Now-a-days router comes in wireless modes using which computers can be 
connected without any physical cable. 

Ø Network Card 

Network card is a necessary component of a computer without which a computer cannot be connected over a 
network. It is also known as network adapter or Network Interface Card (NIC). Most branded computers have 
network card pre-installed. Network cards are of two types: Internal and Extern

Ø Internal Network Cards 

Motherboard has a slot for internal network card where it is to be inserted. 
Internal network cards are of two types in which first type uses Peripheral 
Component Interconnect (PCI) connection while the second type
Industry Standard Architecture (ISA). Network cables are required to provide 
network access. 

Ø External Network Cards 

External network cards come in two flavours: Wireless and USB based. Wireless 
network card need to be inserted into the motherboard b
required to connect to network. 

Ø Universal Serial Bus(USB) 

USB card are easy to use and connect via USB port. Computers automatically detect USB 
card and can install the drivers required to support the USB network card automatically.
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Network cables are used to connect computers. The most commonly used cable is 

A computer can be connected to another one via a serial port but if we need to 
many computers to produce a network, this serial connection will not work. The solution is 

inters, scanners etc. can be connected and then this body will manage 

A router is a type of device which acts as the central point among computers and 
other devices that are part of a network. A router is equipped with holes called 
ports and computers and other devices are connected to a router using network 

days router comes in wireless modes using which computers can be 

nent of a computer without which a computer cannot be connected over a 
network. It is also known as network adapter or Network Interface Card (NIC). Most branded computers have 

installed. Network cards are of two types: Internal and External Network Cards.

Motherboard has a slot for internal network card where it is to be inserted. 
Internal network cards are of two types in which first type uses Peripheral 
Component Interconnect (PCI) connection while the second type uses 
Industry Standard Architecture (ISA). Network cables are required to provide 

External network cards come in two flavours: Wireless and USB based. Wireless 
network card need to be inserted into the motherboard but no network cable is 

USB card are easy to use and connect via USB port. Computers automatically detect USB 
card and can install the drivers required to support the USB network card automatically. 
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connect 
to use a 

inters, scanners etc. can be connected and then this body will manage 

nent of a computer without which a computer cannot be connected over a 
network. It is also known as network adapter or Network Interface Card (NIC). Most branded computers have 

al Network Cards. 
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v Operating System

It is a program with following features: 

· An operating system is a program that acts as an interface between the software and the computer 
hardware. 

· It is an integrated set of specialised programs that are used to manage overall resources
the computer. 

· It is specialised software that controls and monitors the execution of all other programs that reside in the 
computer, including application programs and other system software.

 
 

Ø Objectives of Operating System

· To make a computer system convenient to use in an efficient manner
· To hide the details of the hardware resources from the users
· To provide users a convenient interface to use the computer system
· To act as an intermediary between the hardware and its users and making 

users to access and use other resources
· To manage the resources of a computer system
· To keep track of who is using which resource, granting resource requests, according for 

resource using and mediating conflicting requests from different 
· To provide efficient and fair sharing of resources among users and programs

Ø Characteristics of Operating System

· Memory Management -- keeps tracks of primary memory i.e. what part of it is in use by whom, what part is
not in use etc. and allocates the memory when a process or program requests it.

· Processor Management -- allocates the processor(CPU) to a process and deallocates processor when it is
longer required. 

· Device Management -- keeps track of all devices. This is also called I/O 
gets the device, when, and for how much time.

· File Management -- allocates and de-allocates the resources and decides who gets the resources.
· Security -- prevents unauthorized access to programs and data by means of 

techniques. 
· Job accounting -- keeps track of time and resources used by various jobs and/or users.
· Control over system performance -- records delays between request for a service and from the system.
· Interaction with the operators -- The interaction may take place via the console of the computer in the

of instructions. Operating System acknowledges the same, does the corresponding action and informs the 
operation by a display screen. 

 

· Error-detecting aids -- Production of dumps, traces, error messages and other debugging and error
methods. 

· Coordination between other software and users 
assemblers and other software to the various u
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Operating System 

An operating system is a program that acts as an interface between the software and the computer 

It is an integrated set of specialised programs that are used to manage overall resources

It is specialised software that controls and monitors the execution of all other programs that reside in the 
computer, including application programs and other system software. 

Objectives of Operating System 

mputer system convenient to use in an efficient manner 
To hide the details of the hardware resources from the users 
To provide users a convenient interface to use the computer system 
To act as an intermediary between the hardware and its users and making it easier for the 
users to access and use other resources 
To manage the resources of a computer system 
To keep track of who is using which resource, granting resource requests, according for 
resource using and mediating conflicting requests from different programs and users 
To provide efficient and fair sharing of resources among users and programs 

Characteristics of Operating System 

keeps tracks of primary memory i.e. what part of it is in use by whom, what part is
allocates the memory when a process or program requests it. 

allocates the processor(CPU) to a process and deallocates processor when it is

keeps track of all devices. This is also called I/O controller that decides which
gets the device, when, and for how much time. 

allocates the resources and decides who gets the resources.
prevents unauthorized access to programs and data by means of passwords and similar other

keeps track of time and resources used by various jobs and/or users. 
records delays between request for a service and from the system.

The interaction may take place via the console of the computer in the
of instructions. Operating System acknowledges the same, does the corresponding action and informs the 

Production of dumps, traces, error messages and other debugging and error

Coordination between other software and users -- Coordination and assignment of compilers,
assemblers and other software to the various users of the computer systems. 
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An operating system is a program that acts as an interface between the software and the computer 

It is an integrated set of specialised programs that are used to manage overall resources and operations of 

It is specialised software that controls and monitors the execution of all other programs that reside in the 

it easier for the 

To keep track of who is using which resource, granting resource requests, according for 

keeps tracks of primary memory i.e. what part of it is in use by whom, what part is 

allocates the processor(CPU) to a process and deallocates processor when it is no 

controller that decides which process 

allocates the resources and decides who gets the resources. 
passwords and similar other 

records delays between request for a service and from the system. 
The interaction may take place via the console of the computer in the form 

of instructions. Operating System acknowledges the same, does the corresponding action and informs the 

Production of dumps, traces, error messages and other debugging and error-detecting 

Coordination and assignment of compilers, interpreters, 
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Notepad 

Notepad is a basic text-editing program that comes with Microsoft Windows operating system and its 
most commonly used to view or edit text files. A text file is a file type typically identified by the .txt file 
name extension.  

v Notepad can be used for following Purposes 

1. Notepad can be used to open and edit text files. 
2. Notepad can be used as a Digital Diary. 
3. Notepad can be used to convert Text file into Audio File. 
4. Notepad also can be used to Create WiFi Hotspot. Yes this is 

Possible and very easy. 
5. Notepad is used to edit a wide range of file types including 

.txt, .xml, .html, etc. 
6. The fun part of Notepad is that it can be used to write 

Complex Scripts Such as:  
Shutting Down a Computer  
Creating HTML Webpages. 

 
· Notepad Features 

Following are the features of Notepad. 

1. Notepad has minimal editing features. 
2. Notepad has word wrap which prevents text from running over into the Margins nd automatically moves 

text to the next line. 
3. Used to create/save/open/edit file. 
4. Can create time log. 
5. Within Notepad – cut, copy, and paste text. 
6. Copy data to Notepad from other files. 

7. Copy Notepad text to other word processing text or database document. 

· Notepad Platform 
Notepad runs on all Windows Version such as Windows 95, Windows 98, Windows Me, 
Windows 3.1, Windows 2000, Windows XP, Windows 7, Windows 8 (All Version), 
Windows 10. 

· Notepad Compatibility 
Notepad is Compatible with all Windows 32bit and 64bit Operating Systems. 

· Scroll Bar 
Scroll bar is a vertical bar on the right side of a window or a horizontal bar at the 
bottom of a window that is used to move the window contents up and down or left 
and right. 

· Editing Area 
Editing area is the area where you type in your text and format your document. The 
vertical bar represents the insertion point where your text will appear when you type. 
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§ First of all click on Start Button.  

§ Then Click on All Programs. 
§ Click on Accessories Folder. 
§ After Clicking Accessories, Look for Notepad Icon and Click on it.
§ Open Notepad 

· Shortcut to Open Notepad 
If you don't want to follow all these steps, simply press Windows Key + R to open run dialog box, then type 

 

 

 

 

 

Notepad Explore 

Explorer windows is simply the default window of each 
Notepad, the complete window is known as Notepad Explorer Window. Ther
say, in notepad. We will discuss each of them individually.

· Title Bar 
The Title bar displays the program name and document title. It also 
displays three buttons known as Minimize, Maximize and Close. In the 
following Screenshot, Title Bar is showing BCROY 
the title of the document. "- Notepad" is the common word which 
comes at the end for each notepad file. 
 
 
 
 
 
 

· Untitled Title Bar 
Untitled is a default document title name. If you open notepad for the 
very first time and if you have not yet saved it, Untitled word will be 
shown in the title bar. Once you save the file with a name, that name 
will appear in the title bar. In the earlier image, BCROY is written in 
title bar that means we have saved that file with a name 
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v How to Start 

After Clicking Accessories, Look for Notepad Icon and Click on it. 

If you don't want to follow all these steps, simply press Windows Key + R to open run dialog box, then type 
notepad and press enter. It will open notepad 
application. This process hardly takes 2 seconds.

Notepad Explore WindowNotepad File Menu » 

is simply the default window of each software application which you open. Once you open 
Notepad, the complete window is known as Notepad Explorer Window. There are many parts or section you can 
say, in notepad. We will discuss each of them individually. 

The Title bar displays the program name and document title. It also 
displays three buttons known as Minimize, Maximize and Close. In the 

eenshot, Title Bar is showing BCROY - Notepad. BCROY is 
Notepad" is the common word which 

Untitled is a default document title name. If you open notepad for the 
very first time and if you have not yet saved it, Untitled word will be 
shown in the title bar. Once you save the file with a name, that name 

r image, BCROY is written in 
title bar that means we have saved that file with a name  
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If you don't want to follow all these steps, simply press Windows Key + R to open run dialog box, then type 
notepad and press enter. It will open notepad 
application. This process hardly takes 2 seconds. 

which you open. Once you open 
e are many parts or section you can 
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· Minimize Button 
Minimize Button is used to reduce the current Notepad window to 
Taskbar i.e. if you have opened BCROY notepad file and if you click on 
minimize button, it will remove it from desktop and minimize in 
taskbar.  To open BCROY file again, click on the file in the taskbar.
 
 
 
 
 
 
 
 
 

· Maximize Button 
Maximize Button enlarges the Notepad Window to its original size. 
Suppose you have opened a notepad and it's opened in resized 
windows, then it will enlarge the notepad window to the maximum size 
i.e. size of the screen of your monitor. 
 
 
 
 
 
 

· Close Button 
Close Button is used to close the current Notepad Window i.e. if you 
want to close the notepad file, then simply click on little x button to 
close it. Sometime, if you written something and have not yet saved it, 
then notepad will ask it to save it. If you want to save it, then you can 
save it, else don't save it. This feature is helpful incase if you hav
accidently clicked on cross button. 
 
 
 
 
 
 
 

· Menu Bar 
Menu bar provides functions such as opening files, interacting with an 
application, or displaying help documentation.
File, Edit, Format, View and Help Menu. 
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Minimize Button is used to reduce the current Notepad window to 
Taskbar i.e. if you have opened BCROY notepad file and if you click on 

button, it will remove it from desktop and minimize in 
To open BCROY file again, click on the file in the taskbar. 

Maximize Button enlarges the Notepad Window to its original size. 
it's opened in resized 

windows, then it will enlarge the notepad window to the maximum size 

Close Button is used to close the current Notepad Window i.e. if you 
then simply click on little x button to 

close it. Sometime, if you written something and have not yet saved it, 
then notepad will ask it to save it. If you want to save it, then you can 
save it, else don't save it. This feature is helpful incase if you have 

Menu bar provides functions such as opening files, interacting with an 
application, or displaying help documentation. Menu bar consists of 
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File menu contains options which can be used for document 
handling such as opening a file, saving a file, printing a file, 
setting up page. 
 
 
 
 

Ø File Menu Contains Following Options:

· New: 
New Command let you open a new document.
 
 
 
 
 
 
 
 

· Open: 
Open Command is used to open saved files. Shortcut Key:
 
 
 
 
 
 
 

· Save: 
Save Command will let you save a document on which you were 
working. Shortcut Key: Ctrl+S 
 
 
 
 
 
 
 

· Save As: 
Save As command will let you save a existing document under a 
 

· Difference Between Save and Save As Command:
  
                    Save Command 
Save Command is used to save a document when you 
are saving the file for the first time. 
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v Notepad File Menu 

File menu contains options which can be used for document 
handling such as opening a file, saving a file, printing a file, 

File Menu Contains Following Options: 

New Command let you open a new document. Shortcut Key: Ctrl+N 

Shortcut Key: Ctrl+O 

Save Command will let you save a document on which you were 

Save As command will let you save a existing document under a new name. 

Difference Between Save and Save As Command: 

                   Save As Command 
Save Command is used to save a document when you Whereas in Save As we can save an existing document 

under a new name. 
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existing document 
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· Page Setup: 
Page Setup provides basic page settings such as setting paper 
size, page orientation, margins, header and footer. We will now 
take a look on these Options briefly. 
 

· Paper Option: 
Paper Option consists of paper Size and Source settings. 

· Size: 
Size option let you choose different paper sizes such as A3, A4, 
A5, Executive, Ledger, Legal, Letter, Tabloid. 
  

· Orientation: 
Orientation Option will let you set document in portrait and landscape style. 

· Portrait Style: 
In Portrait Orientation the height of the page is greater than the width. 

· Landscape Style: 
In Landscape Orientation the width of the page is greater than the height. 

· Margins: 
Margin is the area between the main content of a page and the page edges. You can adjust left, right, top, bottom 
margins of your document. By default notepad sets left and right margin as 20, top and bottom margin as 25. 
  

· Header & Footer: 
Headers and footers are text that appears in the top and bottom margins of a document. 

· Preview: 
Preview allows you to view the way document will look after adjusting page setup options. 

· Print: 
Print command allows you to print your current document through the 
attach printer. Shortcut Key: Ctrl+P 
 
 
 
 
 
 
 
Print Option Contains following Settings: 

· Select Printer: 
This option allows you to choose different printers which you would like to choose to print your documents. 

· Page Setup: 
Page Setup provides basic page settings such as setting paper size, custom paper size, page orientation, resolution 
and scale.  

· Page Size: 
Size option let you choose different paper sizes such as A3, A4, A5, Executive, Ledger, Legal, Letter, Tabloid and 
Screen. 
 

· Custom Paper Size: 
By using this option you can set your own paper size by providing width and height values. 

· By default height and width values are set at 297 and 210 respectively. 
· Width and Height values can be provided in inches, points and millimetres. 
· You can also set Paper Resolution value. 
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· Orientation/Order: 
Orientation Option will let you set your documents in portrait and landscape style.

· Portrait Style: 
In Portrait Orientation the height of the page is greater than the width.
 
 
 
 
 
 
 
 
 
 
 
 

· Landscape Style: 
In Landscape Orientation the width of the page is greater than 
the height. 
 

· Scale Option: 
Scale option let you scale your document to a different paper 
size. You can set scale values in percentage for e.g. 90%.
 

· Fonts Embedding: 
Font embedding is the addition of font files inside a document.
 

· Edit Menu: 
 
 
 
 
 
 
 
 
 
 
 

· Undo: Undo command reverses the last editing action.
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Orientation Option will let you set your documents in portrait and landscape style. 

In Portrait Orientation the height of the page is greater than the width. 

In Landscape Orientation the width of the page is greater than 

Scale option let you scale your document to a different paper 
size. You can set scale values in percentage for e.g. 90%. 

dding is the addition of font files inside a document. 

v Notepad Edit Menu 

Undo command reverses the last editing action. Shortcut Key: Ctrl+Z 

 CITA E-Book 

 Page 38 



                                      B.C.Roy Computer Literacy Mission CITA E-Book 

 

E-Book Page 39 
 

· Cut: Cut command let you cut the highlighted text and places it on the clipboard. You must highlight at 
least one character for this command to be available. 

Using Cut command: To cut text so you can move it to another location, select the text, click the 
Edit menu, and then click Cut. Shortcut Key: Ctrl+X or SHIFT+Delete. 

  
· Copy: Copy command let you copy the highlighted text and places it on the clipboard. You must highlight 

at least one character for this command to be available. 
Using Copy Command Shortcut Key: Ctrl+C or Ctrl+INSERT 

· Paste: Paste command inserts the content of clipboard at the existing position of the cursor. Shortcut 
Key:  Ctrl+V or SHIFT+INS 

· Delete: Delete command deletes the currently selected text. Shortcut Key: DEL Key. 
 
 

· Find: By using find option you can search for words or texts in a 
document. Shortcut Key: Ctrl+F 

 
How to use Find Option: 

1. Click the Edit menu, and then click Find. 
2. In the Find what box, type the characters or words you want to 

find. 
3. Under Direction, click Up to search from the current cursor 

position to the top of the document, or click Down to search 
from the cursor position to the bottom of the document. 

4. Click Find Next 

· Replace: 
1. Click the Edit menu, and then click Replace. 
2. In the Find what box, type the characters or words you want to 

find. 
3. In the Replace with box, type the replacement text. 
4. Click Find Next, and then click Replace. 
5. To replace all instances of the text, click Replace All. 

 
Note: To find or replace only text that matches the use of uppercase and 
lowercase characters specified in the Find what box, select the Match case check box. 

· Go To: By using “Go To” option you can go to specific line in a document. 

How to Use Go To Option: 
1. Click the Edit menu, and then click Go To. 
2. In the Line number box, type the line number you want the 

cursor to jump to, and then click Go To. 
3.  You cannot use Go To command when word wrapping is 

enabled. To turn word wrapping off, click the Format menu, and 
then click Word Wrap. 

· Select All: Select All is used to select whole texts in a 
document. Shortcut Key: Ctrl+A 

· Time/Date:  Time/Date option let you insert time and date after every line of date. 
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How to use Date/Time Option: 
1. Click the location in the document where you want to add the time and date. 
2. Click the Edit menu, and then click Time/Date. 

v Notepad Format Menu  

Format Menu contains only two options “Word Wrap” and “Font” 
Options. 

· Word Wrap:  Word Wrap forces all text to be limited 
within defined margins. 

If Word Wrap is Disabled: 

If Word Wrap is Enabled: 

· Font: Font options allow you to change different styles and sizes of a text character. 

Using Font Option: 

1. Click On Format Menu and choose Font option. 
2. A dialog box will appear looking like this. The dialog box 

contains Font options, Font style, size option, sample and 
script option. 

1. From the Font list choose which font you want to use. For 
e.g. select “Lucida Console”. 

2. In “Font Style” option choose which style you want to 
use. The font style option contains Regular, Oblique, Bold, 
Bold Oblique. For e.g. select “Regular”. 

3. In “Size Option” choose which size you want to use. For 
e.g. select “12”. 

Sample Option: Sample gives you an example of how your font look appears. 

Show More Fonts: Clicking on “Show More Fonts” option will open a window showing all fonts installed in your 
pc. 

v Notepad View Menu  

View menu consists of only one option i.e. “Status Bar”.  If status bar is disabled under view menu, no need to get 
panic. Simply uncheck 'word wrap' option under  Format Menu and then status bar will be enabled. 

· What is Status Bar 

The Status Bar is available at the bottom of the notepad which displays document information such as current line 
and character column indicator. 
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Current Line Indicator (Ln) 

This option indicates the current line. If you are on the last line, you will know how many lines there are in your 
document. 

Character Column Indicator (Col) 

This Option indicates the number of character in a column. For e.g. Col 56 represents that there are 5 characters 
in 1 column. 

v Notepad Help Menu  

Almost all softwares of Windows Operating system and other third party software comes with help menu. Help 
menu generally have all the helps and guidelines in step by step easy to follow manner so that readers can read 
and use that software without any issue. Anyone can just read help files and can fully understand how it works. 

Help menu consists of 2 options, View Help and About Notepad. 

· View Help 

View help provides answers to some common questions 
about notepad. 

 

· About Notepad 

About Notepad provides information about Operating system, version of notepad, copyright information, license 
information etc. 
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 Microsoft Paint or 'MS Paint' is a basic graphics/
versions. MS Paint can be used to draw, colour and edit pictures. The extension name of MSPaint is 
Image). 

v How to Open Paint
Start> All Programs > Accessories> Paint
 
 
Or 
Start > Run > type “MSPAINT” > Ok 

 
 
 

This is a typical view of the top of the Paint window.

 

At the very top is the Title Bar, 
just as in all programs, below it 
is a very simple Menu Bar and 
below that is the Ribbon. 

Ø The Title Bar 

At the left end of the Title Bar the first item shows a little paint palette. If 
clicked, this button opens a standard window menu, offering Restore, Move, Size, Mini
You are unlikely to want to use this menu, since all of those things can be done in quicker ways.

The next four items make up the Quick Access Bar

B.C.Roy Computer Literacy Mission 

 

MS Paint 

' is a basic graphics/painting utility that is included in all the Microsoft
can be used to draw, colour and edit pictures. The extension name of MSPaint is 

How to Open Paint 
Start> All Programs > Accessories> Paint 

 
 
 
 
 
 
 

v The Paint Window 

This is a typical view of the top of the Paint window. 

At the left end of the Title Bar the first item shows a little paint palette. If 
clicked, this button opens a standard window menu, offering Restore, Move, Size, Minimize, Maximize and Close. 
You are unlikely to want to use this menu, since all of those things can be done in quicker ways. 

Quick Access Bar, offering buttons for Save, Undo, Redo and Customize
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MicrosoftWindows 
can be used to draw, colour and edit pictures. The extension name of MSPaint is .bmp(Bit Map 

At the left end of the Title Bar the first item shows a little paint palette. If 
mize, Maximize and Close. 

 

Customize. 
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· How to move Quick Access Toolbar to below the Ribbon 

If you'd prefer to have Save, Undo and Redo below the 
ribbon, move your cursor over the left end of the title bar until the Customize icon lights up. Click and a menu will 
appear. 

Near the bottom of the menu that appears, you'll see Show below the Ribbon. Click Show below the Ribbon. 

You'll also see other commands that you can add if you wish. I've chosen to 
add New—for a new Paint page, Open—to open a previously saved and closed picture, and Print Preview. 

You can click any of these item a second time to undo changes you've made to the Quick Access Toolbar. 

4. Adding Ribbon items to the Quick Access Toolbar 

Many other items can be added to the Quick Access 
Toolbar. On the Ribbon, right click on anything you'd like to add to the Quick Access Toolbar and a menu will 
appear. This includes things offered in sub-menus. I've added the Pencil tool and Paste Transparent. 

To remove items you've added from the Ribbon, right click the unwanted icon and then click the Remove option. 
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5. Other things on the Title Bar 

After the Quick Access items, you'll see the title of your picture followed by the name of the program—Paint, of 
course. If you haven't yet saved your picture, the name will be shown as "Untitled". 

At the right-hand end of the Title Bar are the three usual window 
buttons, Minimize, Maximize and Close. If your Paint Window is already maximized—taking up all of your 
screen—the middle button will be Restore, which makes the window the size you usually have it. 

Ø The Menu Bar 

The Menu bar has three items on the left and a Help button at the far right. 

Ø Paint Button 

 

First on the left is the Paint Button, which opens a very comprehensive menu, similar to 
that shown here, plus a list of pictures you've recently saved. Most items are self-
explanatory, but one—Save as— is very important if you ever want to save a cutout 
without losing the rest of your picture. 

You might like to take a quick look at some of the other items and investigate their uses 
as well. 

Properties dialogue 

The Properties dialogue, for instance, will give you information about the picture on 
which you're currently working, and let you nominate whether you want to work in 
centimetres, inches or pixels. (So far, I haven't managed to make any of these 
measurements agree in a printed picture, but this may well be due to my lack of 
experience.) 

There's an option that helps you to set your current picture as your desktop 
background. You can change this as often as you like. 

Ø Home Tab 

For nearly everything you do, you'll want the Home tab to be at the front. The Home tab contains the Ribbon, 
from which tools and colors are selected. When you're making use of the View tab, you can flick back and forth 
between Home and View as often as you need to. 
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Ø View Tab 

Zooming in and out is one of the features that Paint in 
Windows 7 has improved out of sight! Click on the View tab to bring it to the front and you'll find a whole set of 
useful options available. These can be used alone or in conjunction with the Zoom Tool on the Ribbon or the slider 
on the Status Bar. 

Zoom in and Zoom out tools can be clicked repeatedly to get a closer or more distant view. 

The 100% option is handy when you've finished working in a very zoomed in view. One click and you're back to 
normal. 

On the Show or Hide part of this tab, you have the option of hiding the status bar. I wouldn't advise you to do 
that. The status bar can be useful. 

Gridlines are convenient if you want to align shapes accurately. 

Rulers? If you like. Turn them on and see what you think. 

On the Display section, you can click for Full Screen View. You can also get a Full Screen View by hitting F11. In 
either case, come back to a normal view by pressing the Esc key. 

Thumbnail is only available when you are zoomed in. It lets you see how changes you make are affecting your 
picture in normal view. So far, I'm finding that the thumbnail cannot always show work on the far right or the 
bottom of the page. 

You can flick back and forth between the Home tab and the View tab as often as you like. 

Ø The Ribbon 

All the tools, the color palette, and most commands are grouped together in the ribbon. The exceptions 
are Save, Undo and Redo, which are shown at the left end of the title bar, in the Quick Access Toolbar. 

If you choose to use a very small window, the ribbon 
will appear like this. Drop-down arrows below each item will give you access to everything in their menus. 

If, however, you use a very large window, you will have many more menu items on display. 
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There is also an option to minimize the ribbon. If you choose this, the ribbon disappears entirely, but pops into 
view if you click on the Home tab. 

Ø The Clipboard Menu 

The clipboard menu offers three options—Cut, Copy and Paste. Only when a selection is 
active will the Cut and Copy icons show as being ready. 

Paste is always active, because you may wish to Paste from a picture on your computer. Say 
you've previously drawn and saved a small flower and now wish to add it to your present drawing. You'd click the 
down arrow under Paste, click Paste from and navigate to the saved picture, click its name and click Open. 

You'd be returned to your work space and see the added picture inside a selection rectangle, ready for you to drag 
to its permanent position. 

Ø The Image Menu—Select 

Depending on the size of your window, the Image Menu will 
look like one of these. When you click the down arrow just below the dotted 
rectangle, or just below the word Image, a menu will offer you further choices. 

Before you can use the buttons on the right of this menu, you select the part of 
your drawing that you want to work with. 
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6. Transparent selection 

At the bottom of the Select menu you'll see Transparent 
selection. You'll want to use this often, so it's a good idea to add it to your Quick Access toolbar. To do this, right 
click on Transparent selection and then click on Add to Quick Access toolbar. On your Quick Access Toolbar, 

there'll be a checkbox in front of the words Transparent selection. While that box has a 
tick in it, selections will be transparent. 

To make your selections opaque, just click the checkbox to remove the tick. 

7. Rectangular selection 

Usually you'll make a rectangular selection. After clicking the rectangular selection tool, position the cross-hair 
cursor at the top left of the part you want to select, press your mouse button and drag down to its bottom right. 

(Actually, you can start at any corner, so long as you finish at the corner diagonally opposite.) 

A dashed rectangle will appear around your selection, with the move cursor  replacing the cross-hair one. You 
can press this cursor down anywhere inside your selection and drag to move it, or drag while holding the Ctrl key 
to make a copy of it. 

8. Freeform selection 

You may need to make a Freeform selection if the part of your drawing that you want to work with is crowded up 
closely with parts you don't want to include. 

After clicking Freeform selection, drag your mouse around the area you want, as 
though you were drawing a line around it. When you release the mouse button, a selection rectangle will appear 
and it may seem that unwanted parts of the drawing have been included, but if you move the selection you'll see 
that this is not so. 

9. Copying a selection 

There is, of course, a Copy button on the ribbon, but this way is faster, 
particularly if you want to make multiple copies of a selection. 
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Draw a selection around the part you want to copy, using either the rectangular or the freeform selection tool. 

Hover your cursor over the selection until the Move Cursor  appears. 

Hold the Ctrl key as you begin to drag a copy to its new location. Click. If you want to continue copying, press the 
Ctrl key again as you begin to drag the second time. Repeat as many times as needed. 

Painting with a selection 

Try this. Select a tiny piece from a picture, choosing something with 
more than one color. Hold down the Shift key while you drag it around to make an abstract pattern. 

You can even try writing with a tiny selection, although you will need to zoom in and use the pencil to tidy up 
blobby bits where you started and finished. 

Ø Selection options 

To the right of the selection icon you'll see three options, Crop, Resize and Rotate flip. 

10. Crop 

The top button, a diamond shape with a line through it, lets you crop your picture so that only the selected area 
remains. This has replaced the old Copy to option and is tricky if you want to save cutouts from a drawing. 

If you click the Save icon after cropping to a selection, your large drawing page will be replaced with the cutout. 

11. How to save a cutout 

1. Save the picture you're working on. 

2. Select the part you want to save as a cutout. 

3. Click the Crop button. 

4. Go to the Paint button and open the menu. 

5. Click Save as 

Be very sure that you do click Save as and not Save. 

6. Type a name for the cutout and click Save. 
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You'll be returned to the Paint window with the cutout displayed in it. You'll see that the name on the 
Title bar is the name you used when saving the cutout. 

7. Click the Open icon on your Quick Access Toolbar or from the Paint Button menu.  

8. Open the picture with which you wish to continue working. 

Ø Resize and Skew 

 
The second tiny button to the right of the large Select button will open the Resize and Skew dialogue. 

. 
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12. Resize 

You can quickly resize a selection by dragging any of the little blocks—or handles—on the 
selection rectangle. Just hover your cursor over the handle you want to pull or push until a double-ended arrow 
appears. Press down your mouse button and adjust the shape to your liking. 

However, if you want the size adjustment to be precise, use the Resize dialogue, which will appear when you click 
the Resize icon. Only the top half of this dialogue is concerned with resizing. 

Notice the small square marked Maintain aspect ratio. While this is ticked, whatever you type into the Horizontal 
slot will be repeated beside Vertical and your selection will stay exactly in proportion. Only remove the tick if you 
want the selection to be fatter or thinner than it is. 

13. Skew 

The bottom part of the same dialogue box invites you to skew your selection. When using this 
option, make your selection include a lot of border area to avoid having part of the picture chopped off, as has 
happened here. If this does happen, click Undo  and make a wider selection before trying again. 

However, when I tried to skew a heart shape from the Shapes gallery, I had some extra color 
added, apparently from nowhere. How odd! Ah! Now I see. I had red set as Color 2. I've learned something! 
Always have your background color—most probably white—on Color 2 when skewing, moving or whatever. 

. 

You'll need to experiment with the skew option. Quite small numbers have a marked effect. This 
selection has been skewed 30 degrees both horizontally and vertically. The other blue box was skewed 20 degrees 
horizontally. 
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Ø Rotate or flip 

This menu lets you make mirror images of selections, either vertically or horizontally, and 
it also lets you rotate an item 90 degrees. 

Making a mirror image is handy if you're trying to draw something that looks symmetrical. Just copy half of the 
picture, flip it and join it to itself.  

Invert Color  

A different set of options is available if you right click on a selection you've made. 

Items include: Cut, Copy, Paste, Crop, Select all, Invert selection Delete, Rotate and Resize, but the one that seems 
to be available on this menu and nowhere else is Invert color, the last item on the menu. This is very important if 
you want to make a black mask with white lettering to create a fancy fill for text. 

Ø The Tools Menu 

 

14. Pencil 

The pencil tool can be used for free-hand drawing, or it can be used in a zoomed in view for pixel-by-pixel 
editing. 
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When working with the pencil tool, press with the left mouse button to draw with Color 1 and with the right 
mouse button to draw with Color 2. Color 1 in previous versions of Paint was referred to as the Foreground color, 
while Color 2 was the Background color. 

In Paint for Windows 7 the pencil's thickness can be changed in the Size tab to 1, 2, 3 or 4 pixels. 

15. Fill with Color 

The Fill with color tool, or the Flood Fill tool if you like, is used to fill an area of a single color with a different 
color. Color 1 will be used if you press the left mouse button on the area to be filled. Color 2 will be used if you 
press with the right mouse button. 

This tool won't work successfully if the part you are trying 
to color is textured or has different shades of one color. It won't work well on areas in a photograph. Even though 
the eye may see just one color, there are bound to be many. 

Here I've snipped a "plain" brown area from a photo. The second picture shows how a small section of it looks 
when it's magnified. To make the third picture, I had Irfanview adjust the brightness of the magnified section. The 
Fill with Color tool can only recolor pixels that are exactly the same. 

The Fill with Color tool always fills with a solid color—unless you are filling shapes that you've just made from the 
Shapes Gallery and have a textured fill chosen there. 

Ø The Text Tool 

The Text tool in Paint for Windows 7 is a great improvement on earlier versions.

 The one exception to this is that Paint 7 always anti-aliases text, so the 
idea of stacking red text on top of black to get a shadowed effect seems to be a thing of the past—unless you turn 
off Smooth screen fonts in the Performance section of Advanced System Settings. 

You can, if you like, just go ahead and insert your text as you always have, but I'd recommend that you open a 
new document and play with this tool. 

To begin inserting text, click on the text tool. Your cursor changes to an insertion bar. 
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With this cursor, drag to draw an oblong that you think will be about right to hold your text. 

Now, until you've completed these steps, don't click anywhere outside that oblong. 

The Text Toolbar appears. 

Type your text. 

Now drag the cursor over the text so that it becomes highlighted. 

Click the down arrow at the end of the Font Name box, so that a list of fonts drops down. 

Run your cursor—without pressing any mouse buttons—up and down the font list. As you do this, the appearance 
of the text you've typed will change appropriately. 

When you like what you see, click on the name of that font. The font list will close. 

You can repeat this process with the Font Size list. 

You can also click the Background from Transparent to Opaque or vice versa, and change both Color 1 and Color 
2. You can even run your cursor, while the Color 2 button is operative, over the palette, and see how different 
backgrounds look behind your text. 

You can hover your cursor over any of the handles—little blocks—on the bounding box of the text, press your 
mouse button and resize the box you've drawn, and if you hit the enter key from the end of your text the box will 
expand downwards. You can also use the handles to move the text box across the page, pulling it wider on one 
side and pulling it in on the other. 

Although there is no way to centre your text automatically, you can put your cursor to the left of the text and hit 
the space bar as many times as necessary to centre it. 

And that's not all. You can type more text, in a different color 
and a different font and size, right in the same text box! When you are making changes, only highlighted text will 
be affected. 

Oh! And in this version of Paint, you can use the Text Tool while zoomed in! Use the slider on the status bar to 
change zoom levels, though. Clicking on the Magnifier pastes the text. 

Only when you are completely satisfied should you click anywhere on the page outside of your text box. When 
you click away from the text box, the Text Toolbar disappears and the text becomes part of your picture. It can no 
longer be edited in any way. 
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Ø The Eraser 

With the left button depressed, the eraser tool changes whatever it is dragged across to the background 
color—Color 2. 

With the right button depressed, the eraser tool changes pixels of Color 1 to Color 2, but leaves everything else 
unaffected. You can use this to quickly and easily change an area of, say, red to one of, say, blue. 

I pressed the left mouse button while I dragged the Eraser 
across the first picture. Color 2, the background color, was white. 

For the second picture, I set Color 1 to blue and Color 2 to white. 

I pressed my right mouse button while I dragged across the picture. 

For the third picture, I set Color 2 to pink and Color 1 to lime green. I pressed my right mouse button while I 
dragged across the picture. 

There's no color tolerance in Paint; only pixels of exactly the same color are affected, so it's pretty useless on 
textured color. 

Ø The Color Picker 

The Color Picker Tool is used to sample and match any color in your picture. 

It's especially useful when colors in the picture are different from those on the palette. 

Say you're zoomed in, working with the Pencil tool on an area that has many shades of blue, and you want to use 
one of those shades. Click the Color Picker and click directly on the shade of blue that you want to use. The tool 
will immediately change back to the Pencil, loaded with the color you want. 

Ø The Magnifier 

The Magnifier Tool can be clicked over an area of which you want a closer view. Left clicks give a closer view. 
Right clicks zoom out. So much less clunky than in previous versions of Paint! 
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Ø Brushes 

Brushes let you paint in various widths and textures. 

Widths are controlled by the brushes and the Size Tool together, textures by the brushes. 

Please remember that anything you plan to recolor needs to have plain, solid color to begin with. All but two of 
the brushes use different shades of the base color to produce a textured effect. 

Here I've drawn a line with each of the offered brushes, 
using the same color and the same line width for each. I've labelled each line according to its tooltip in the gallery. 

On the right I've dragged the color eraser from top to bottom through all the different brush lines. You can see 
that only two lines, those labelled "Brush" and "Airbrush", are able to be fully erased; that is, each of the others 
uses more than one shade of green. 

It can be helpful to consider the brushes as three separate items: the normal Paintbrush, the Spray Can or 
Airbrush, and the rest as Special Effects Brushes. The normal Paintbrush is the default, so that helps. 

. 

I found the calligraphy brushes interesting. I was able to write a letter fairly convincingly with 
Calligrahy Brush 1. I was a dead loss with Calligraphy Brush 2. 

Once you have chosen a brush, you only need to click the main brush picture to use that same brush again. 
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Ø Shapes 

A bit confusingly for users of previous versions of Paint, the Line Tool and the Curved Line 
Tool have been cunningly concealed in the Shapes Gallery, along with Rectangles, Rounded Rectangles Ellipses 
and Freehand Polygons. As well, though, there are a number of added shapes: arrows, speech balloons, various 
stars and others. 

Ø Basics for All Shapes 

Open the Shapes Gallery by clicking the down arrow under the Shapes picture and click 
the shape you want to draw. You have to have chosen a shape before you try to use the Outline or Fill buttons and 
before you choose a line thickness. 

 

Please be aware that if you choose Solid Fill when your background color is set to white, the shape will be filled 
with white until it is pasted, and ditto with Solid Outline drawn with the right button. That is, if you move the 
shape onto a colored area while its bounding box is still active, the white fill will show. 

However, if the shape is pasted onto a white area and later selected and moved onto a colored part of the picture, 
the white part will then be transparent. 

. 
Having chosen a shape, click the Outline button to the right of the Shapes picture and click on Solid Color or a 
texture of your choice. 

Click the Fill button and click on No Fill, Solid Color or a texture of your choice. 

Click the down arrow below the Size picture and click on a line thickness. 

Press a mouse button and drag to draw the shape. 

If you draw with your left mouse button, Color 1 will be used for the Outline. 
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If you draw with your right mouse button, Color 1 will be used for the Fill. 

Once you've drawn a shape, but while the bounding box is still visible, you can change Color 1 and Color 2, you 
can change the line width, alter choices in the Outline and Fill lists, drag handles to change the size and 
proportions of the drawn shape or move it to a different place in your picture. 

When you are fully satisfied, click well away from your newly drawn shape to cancel the bounding box and paste 
the shape into your picture. 

16. Straight Lines 

Straight lines are the first offering in the Shapes Gallery. 

Open the gallery and click the Line button. Click the Outline button and click on Solid Color or a texture of your 
choice. 

Click the Size drop-down and click a line thickness, then select colors. Lines drawn while the left mouse button is 
pressed will use Color 1, those drawn with the right button will use Color 2. 

Draw your line. It will be perfectly straight. 

If you hold down the Shift key while drawing a line, it will be precisely horizontal, precisely vertical, or precisely at 
45 degrees. 

17. Curved Lines 

The Curved Lines tool isn't quite as easy to use as it once was. Closed curves don't come 
with just three clicks, and if you're familiar with my eight petalled flower from earlier versions, that doesn't work 
in Paint for Windows 7! I've written fresh directions, but on a separate page.  Meanwhile, here are the basics of 
drawing curved lines. 

Click the little arrow under the Shapes picture and click the  Curved Line button. 

Click the Outline button and choose Solid Color or a texture of your choice. Then click under the Size picture and 
choose a line thickness. Choose colors if you wish. 



                                      B.C.Roy Computer Literacy Mission CITA E-Book 

 

E-Book Page 58 
 

Draw a line. 

For a pointed curve, like this one, put your cursor somewhere near the finishing end 
of the line. With the mouse button pressed, move the cursor around slowly and watch the line following it. When 
you think the line is where you want it, release the mouse button. 

Now put your cursor somewhere close to the beginning of the line, press the mouse button and again move the 
cursor slowly around until you like what you see, then release the mouse button. 

To make a smooth curve, after you have drawn your line, put your cursor close to 
the beginning of the line. 

With the mouse button pressed, move your cursor around slowly until you feel the curve is almost as you want it 
and release the mouse button. 

Now press your mouse button down near the end where you finished the line. Move the cursor around until you 
are happy with the curve, then release the mouse button. 

18. Closed Curves 

To draw a closed curve,first draw a triangle—to be erased later. Make the triangle short and 
fat or tall and skinny, depending on the finished shape you want. Be sure to use a color other than the color you'll 
use for your finished shape, so that you can erase it easily. 

Having chosen the Curved Line tool, and set line thickness and color, put your cursor where you want the point of 
the shape. 

Press your mouse button and move the cursor the tiniest bit, just enough to 
convince the program that you've drawn a very short line. Release the mouse button and click once on each of the 
other points of the triangle. 



                                      B.C.Roy Computer Literacy Mission CITA E-Book 

 

E-Book Page 59 
 

19. Repeated Curves 

Problems with the bounding box 

When you're drawing several curved lines one after the other, you'll find it helpful to click the selection tool or the 
pencil when each curve is completed. When you do this it cancells the bounding box around the completed 
curve. Then go back to the Shapes tool and choose the curved line again. 

20. Elipses, Rectangles, Circles and Squares 

If you want to draw an exact shape—say a square or a circle—hold the Shift key while you draw and release the 
mouse button before you let go of the Shift key. 

21. Freehand Polygons 

To draw a freehand polygon, click the Polygon button  in the gallery. After 
setting Line, Fill and so on, hold a mouse button down and draw the first line of the polygon. Then release your 
mouse button and click where you want the next line to end. Keep clicking end points until you want the last line 
to finish the shape, then double click. 

Ø Line Thickness, The Size Tool 

This tool becomes active only after you have chosen either a Brush or a Shape, so choose your Brush or 
Shape and you'll then find you can click the down arrow under Size and choose a line thickness. 

The line thicknesses offered vary according to the brush you've chosen. 

Ø Colors 

The Color section of the ribbon has three parts: Boxes showing the active colors—Color 1 and Color2, the Color 
Palette and the Edit Colors button. 
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22. The Color Boxes 

Color 1 is the Foreground Color, and is always black when you open Paint or open a 
different Paint page. 

Color 2 is the Background Color, and is always white when you open Paint or open a different Paint page. 

To change a color, make sure that its Color box is in focus, as shown by the yellowy background. If it is not, simply 
click it and then, in the Palette, click on the color that you want. 

When you have an active shape or some active text on your page, hovering your cursor over a color in the Color 
Palette will make the shape or text take on that color temporarily. You can click to apply the change if you like it. 

23. The Color Palette 

The two top lines of the Color Palette show all the colors available whenever 
you are making a picture. 

The line of blank squares at the bottom will show any colors you have edited during this session. Once Paint is 
closed, those colors will vanish away. 

24. Edit Colors 

The Edit Colors button takes you into the Edit Colors dialogue. There you can click any color on an 
extended palette and click the Add to Custom Colors button. 

You can also, if you wish, alter the depth of the chosen color by clicking any point on a sliding "dark to light" scale 
on the right of the dialogue, before you click the Add to Custom Colors button. 

When you click O.K. in this box, only one color will be added to the squares under the palette. To add further 
colors, you must return to the dialogue and add them one at a time. 

As I said, the Custom Colors are kept only during one session. If you particularly want certain colours to use the 
next time you open Paint, make little swatches of them on an actual picture. You might like to then crop to the 
swatches, do a Save as—calling the cutout "Custom Colors", so that you can Paste from the saved swatches on a 
later occasion. 
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Ø The Status Bar 

 

The Status Bar sits at the very bottom of the Paint Window, where it offers information and can be used to help as 
you work. We'll look at it's features from left to right. 

25. Cursor Position 

Gives your Cursor Position, which is helpful when you want to position something precisely. 

26. Selection Size 

Shows the size of a selection you're making, or of an object you're drawing. 

27. Image Size 

Shows the size of your entire picture, even if it is very large and so not all visible in the window. If 
you haven't changed the units in the Properties dialogue this measurement will be in pixels, but you do have the 
option of changing to inches or centimetres. 

28. Disk Size 

Once you've saved a picture, this will show its Size on Disk. In a very small window, this figure may 
not be shown. 

29. Zoom Slider 

The Zoom Slider is convenient if you're working in a zoomed-in view and want to 
zoom out. However, you can't zoom in on a particular spot, as you can with the Magnifier. 

Ø Saving Your Work 

It's a good idea to save your picture as soon as you begin, then click the Save button on the Quick Access 
Toolbar every few minutes. This saves loss of work if the program closes unexpectedly, as in a power failure. If in 
the end you don't much want to keep the picture, you can always delete it. 
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When you hit Save for the first time, you'll find yourself in a dialogue box where you're invited to type a name for 
the picture. Do so, and accept the default format, which i
choosing some other format. Having typed a name, click the

After that, when you click the Save button your work won't be interrupted.

Saving a Copy—Save as 

Sometimes you may have made a really good picture, want to add something to it but worry that you might spoil 
it. The thing to do then is Save a Copy. 

Go to the Paint button and open the menu.

Click Save as 

In the dialogue box, the existing name of the picture will be suggested. Just change it a little by adding, say, a "2" 
or the word "Copy", then click the Save button.

You will be returned to the Paint window with the copy ready for you to work on. Now you can make changes 
with confidence, knowing that if things do go wrong your original picture is safe and unchanged.

           WordPad is a basic word processor that is included with almost all versions of Microsoft Windows from Windows 95 onwards. It is 
more advanced than Microsoft Notepad but simpler than Microsoft Works Word Processor and Microsoft Word. It replaced Microsof
Write. 

         Microsoft WordPad is capable of editing and saving plain
.docx), and Open Document Text (.odt) format files. 

 

 

1. Open WordPad 

To open WordPad, click Start then Programs then Accessories then Word
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for the first time, you'll find yourself in a dialogue box where you're invited to type a name for 
the picture. Do so, and accept the default format, which is png—unless, of course, you have a particular reason for 
choosing some other format. Having typed a name, click the Save button and you'll be returned to your picture.

After that, when you click the Save button your work won't be interrupted. 

Sometimes you may have made a really good picture, want to add something to it but worry that you might spoil 

Go to the Paint button and open the menu. 

e of the picture will be suggested. Just change it a little by adding, say, a "2" 
or the word "Copy", then click the Save button. 

You will be returned to the Paint window with the copy ready for you to work on. Now you can make changes 
wing that if things do go wrong your original picture is safe and unchanged.

v WordPad  

that is included with almost all versions of Microsoft Windows from Windows 95 onwards. It is 
more advanced than Microsoft Notepad but simpler than Microsoft Works Word Processor and Microsoft Word. It replaced Microsof

is capable of editing and saving plain-text file (.txt), Rich Text Format (.rtf), and Word for Windows 6.0 (.doc or 

To open WordPad, click Start then Programs then Accessories then WordPad. 
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for the first time, you'll find yourself in a dialogue box where you're invited to type a name for 
unless, of course, you have a particular reason for 

button and you'll be returned to your picture. 

Sometimes you may have made a really good picture, want to add something to it but worry that you might spoil 

e of the picture will be suggested. Just change it a little by adding, say, a "2" 

You will be returned to the Paint window with the copy ready for you to work on. Now you can make changes 
wing that if things do go wrong your original picture is safe and unchanged. 

that is included with almost all versions of Microsoft Windows from Windows 95 onwards. It is 
more advanced than Microsoft Notepad but simpler than Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft 
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Once WordPad is open, you should see a window similar to below.

 

 

 

 

 

 

2. The Menu Items and Tool Bars 

The Menu Bar 

 

 

 

 

Ø File Menu 

New: This creates a new WordPad document.  

Open: This allows you to open a saved file  

Save: Protect your document by frequently using the Save command. 

Save As: Use this command to save an existing document under a new name or to create a name for 
anew file.  

Print: This command allows you to choose your printer and its properties, such as the 
size. It also allows you to choose the print range and the number of copies. 

Print Preview: Look at the document on screen before printing

Page Setup: Set the orientation and Printer Recent  

File: Previously edited documents 

Send: Direct the document to other locations 

Exit: Quit using WordPad 

   

 

Ø Edit Menu 

Undo: Undo the last command 

Cut: Removes highlighted text and places it on the clipboard

Copy: Copies highlighted text and places it on the clipboard

Paste: Places text from the clipboard into your document 
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Once WordPad is open, you should see a window similar to below.

Protect your document by frequently using the Save command.  

Use this command to save an existing document under a new name or to create a name for 

This command allows you to choose your printer and its properties, such as the paper source and 
size. It also allows you to choose the print range and the number of copies.  

: Look at the document on screen before printing 

Removes highlighted text and places it on the clipboard 

Copies highlighted text and places it on the clipboard 

Places text from the clipboard into your document  

 CITA E-Book 

 Page 63 

Once WordPad is open, you should see a window similar to below. 
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Clear: Removes all highlighted text from the document 

Select All: Highlights all the text in the document 

Find: Look up words or phrases in document. 

Replace: Replaces words or phrases with other words or phrases

Ø View Menu  

 

Toolbar: Shows Toolbar icons when checked

Format Bar: Shows Formatting icons when checked

Ruler: Shows Ruler when checked

Status Bar: Shows Toolbar icons when checked

Options: Shows the ch

  

Ø Insert Menu 

 Date and Time: Use this command to place the date and time in your document and choose 
the format. 

Object: Selecting this choice will present a screen shot 

   

  

Ø Help Menu 

Help Topics: will allow you to search for the specific topic desired.

About WordPad: Opens a window describing the version of WordPad being used.

 

Ø Format Menu 

 

Font: This allows you to the select the shape of the letter as well as the font style, size, effects 
and script. 

Bullet Style: This will add a "bullet" to your list  

Paragraph: Set the indentation and alignment of text 

Tabs: Set the tab stops in the document 

 

 

 

 

Ø The Standard Bar 
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Removes all highlighted text from the document  

Replaces words or phrases with other words or phrases 

Shows Toolbar icons when checked 

Shows Formatting icons when checked 

Shows Ruler when checked 

Shows Toolbar icons when checked 

Shows the choices below..... 

Use this command to place the date and time in your document and choose 

 

specific topic desired. 

window describing the version of WordPad being used. 

This allows you to the select the shape of the letter as well as the font style, size, effects 
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New 

Document Save 
time/date 

 

                                                                                                                             
Open File Print  Find   Copy  Undo 

  

Ø The Format Bar  

Ø Ruler 

Use the ruler at the top to define the edges of your text, just move the ruler cursor to define the width of your document.
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 Print Preview     Cut Paste 

                                                                                                                                                                                                                                                          

define the edges of your text, just move the ruler cursor to define the width of your document.
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define the edges of your text, just move the ruler cursor to define the width of your document. 


